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Preface

Using Mac Kermitis your guide to Macintosh Kermit, a powerful yet easy touse data comrmunication

program for the Apple Macintosh computer. With Mac Kermit, you can carry on interactive dialogs
with any computer or information service that you can connect your Mac to, either directly or by

dialup modem, and you can transfer both text and binary files with any other computer or service that

also supports Columbia University’s Kermit file transfer protocol.
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The Kermit file transfer protocol transmits data conveniently and correctly. Software programs
based on this protocol have been written for hundreds of different computers and operating systems
by skilled and dedicated volunteer programmers from all parts of the world. Mac Kermit is one of
the most popular of all Kermit programs.

The Mac Kermit program that is packaged with this book runs on the entire Macintosh family of
computers except the original 128K Mac. Mac Kermit includes high-quality DEC VT320
international terminal emulation and one of the most advanced implementations of the Kermit file
transfer protocol to be found anywhere.

Kermit software is neither commercial nor sharewhare. It is freely distributed software that is
protected by acopyright. MacKermit may be copied, shared with your family, friends, or colleagues,
and redistributed as long as it is not done for profit. This unusual status is one of many factors that
contribute to Kermit’s international growth and popularity. :

Since the early 1980s, when the first Kermit program was introduced, computers have become
progressively more powerful, user interfaces more sophisticated, and the data communication
environment more complex and varied. During these years, Kermit software has tried to keep pace
with the growing power of computer systems and the expanded needs of the people who use them.
The once simple Kermit programs have matured into powerful communication tools that can do
much more, and do it better. This book is here to get you started with Mac Kermit and to help you
master its many capabilities.

Every microcomputer user should be aware of the increasingly common virus attacks upon software.
Copying Macintosh programs from your friends or downloading these programs from computer
bulletin boards could leave you with infected software. For this reason, I strongly recommend that
you obtain Macintosh, PC and other Kermit software directly from safe sources: professionally
published books in the Kermit series, or from the Kermit Distribution office at Columbia University

for a moderate distribution fee:

Kermit Distribution

Columbia University Center for Computing Activities
612 West 115th Street

New York, NY 10025, USA

Write to this address for a catalog of Kermit software available, or to be placed on the subscriber list
of the free publication, Kermit News.
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Introduction

Click your mouse on the Mac Kermit icon and your Macintosh can become virtually any computer
it desires. It’s like opening a window to the world’s computers and information services.

The Apple Macintosh is one of the most popular personal computers in offices, schools and homes
because it is so easy to use: “the computer for the rest of us”. Its most appealing feature isits graphical
menu system that works in a consistent way for most Macintosh applications. The Macintosh
software arranges items pictorialty on your screen as “icons” - small pictures of diskettes, manilla
folders, pieces of paper-— with a short menu of things you can do with them: file, edit, and so on.
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If you think of a disk icon as a filing cabinet, there is probably some organization (documents inside
folders) and some disorder (documents also outside of the folders). You might even have some
folders inside other folders. The amount of chaos that appears on your desktop is up to you.

Most first-time computer users (and many experienced ones too) find controlling a program’s
behavior with a mouse to be a convenient alternative to typing commands: simply move the mouse
to a menu item and press down its button to view the possible choices, then move the mouse again
to select the desired choice. Starting a Macintosh program is easy too — move the mouse to the
program’s icon and press on the mouse button twice. The program’s menu appears automatically
and choices are abundant.

Macintosh Kermit is a communications software program for your Macintosh, It lets you reach out
from your Mac to other computers, carry on interactive dialogs, and transfer files, With Mac Kermit,
your Macintosh computer can communicate as far beyond the limits of your desktop as your
telephone budget will allow. You can access dialup information services like Compuserve, Dow
Jones News/Retrieval, and MCI Mail from your office, your home, or your dormroom. All you need
is a Macintosh computer, the Mac Kermit software program, a cable, and perhaps a modem,

What Mac Kermit Can Do For You

If you want to interact with another computer without leaving your Macintosh, you need a
communications software program that makes your Macintosh actlike a terminal. Guess what? Mac
Kermit can do that. Itcan give you the illusion of having the other computer at your fingertips. And
if you want to exchange data reliably with another computer, you need file transfer software. You
might have suspected that Mac Kermit can do that too.

You could pay money for every minute you spend reading that list of cars for sale. Or, you could
put the information on your Mac and read it at your leisure instead, You can write that reporton your
home Macintosh and copy it to the office computer where your co-workers can access it. You can
exchange compatible types of spreadsheet, database, word processor, electronic publishing, or
graphical data not only with other Macintoshes, but also with IBM PCs, DEC VAXes, UNIX
computers, IBM mainframes, and many other kinds of computers, You can even transfer text written
in different langnages with other kinds of computers that use different character sets. All of this can
be done. And you now have the software to do it with.

Mac Kermit's Features

Mac Kermit gives you the ability to make connections by dialing up an information service oranother
computer either through the telephone system, or by connecting the two computers together with an
inexpensive data cable, Once you have made your connection, Mac Kermit’s terminal emulator lets
the computers and services you interact with control the appearance of your screen so itlooks the way
you would expectit toif you were using areal terminal instead of your Mac, Mac Kermit can emulate
most features of the DEC VT320 terminal including display and entry of international characters,
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which makes Mac Kermit a favorite in many countries. During terminal emulation, Mac Kermitcan
change fonts and sizes, roll back your session screen, save your session to a file, and cut and paste
to and from other Macintosh applications.

The Mac Kermit software is written in the C programming language and is based on the C-Kermit
5A program for UNIX and VAX/VMS, one of the most advanced of all Kermit protocol implemen-
tations. It includes support for text, binary, and MacBinary transfers over both 7-bit and 8-bit
communication channels, long packets, sliding windows, transmission and preservation of file
attributes, character set conversion, automatic parity detection, dynamic packet sizing, file group
transfer, file transfer interruption, filename collision actions, 16-bit CRC error detection, sophisti-
cated error recovery procedures, client and server operation, and much more.

Data Communications Software

Using the Mac Kermit program, or any other communications software, is more complicated than
using self-contained Macintosh application because there are two computers involved and a con-
nection between them. All of these elements must be in synch for communication to occur.
Attempting to use Mac Kermit without the preliminary setting up and checking will probably fail and
only leave you frustrated.

It’s best to get familiar with the Macintosh computer first, then install the software, and then see how
to connect your Macintosh to the other computer. After all that, you can learn how to use Mac Kermit.
This book can be the road map to guide you through your journey. The chapters that follow are
designed to help you set everything up for successful communication and then learn how to use the
Mac Kermit to do the communicating,.

Using Mac Kermit Page 3
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Macintosh Fundamentals

Let’s take a few minutes to get familiar with the basic techniques and terminology that all Mac users
should know. These terms are used throughout this and other Macintosh books and manuals. For
further details, consult your Macintosh System Software User's Guide.

Starting Your Macintosh
If your Macintosh computer is turned off, turn on the power switch. If you have a Macintosh I with
a Power-On key on the keyboard, press that key. If your Mac is a diskette-only system, insert your
Macintosh startup diskette. Your Macintosh is ready to use when the mouse pointer — a small arrow
pointing towards 11 o’clock — appears near the upper left corner of the screen.

d = File Edit Uiew Special Color )
k enu Bar
\‘ N —
Mouse Pointer hard disk 80
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Trash
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The Menu Bar
Across the top of the screen is a bar that should have a picture of an apple on the left, followed by
the words File, Bdit, View, and Special. Some applications might have different words in their
menus, but there should always be a menu bar at the top of the screen.
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Inserting a Diskette

All Macintosh diskettes are encased in a 3.5-inch square hard plastic case. The small arrow on the
diskette should be on the side facing up and pointing towards the slot in the diskette drive. One corner
of the diskette, opposite the arrow, is cut diagonally. Insert the diskette with the cut corner on the
right. Push it in until it clicks into place,

Icon

Below the menu bar on your Macintosh screen you should see some little pictures with words under
them. These are called “icons”. Anicon canrepresent a disk, an application, or some other kind of
thing. Forexample, you should see a picture of a trash can in the lowerright, labeled “Trash”. That’s
the trash icon, which is used for discarding things. When a readable diskette is inserted, an icon is
created for it: a picture of your diskette with its title underneath.
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Mouse

The mouse is your primary means of controlling the Mac. It lies flat on your desktop (some people
prefer to keep it on a rubber “mouse pad” for better traction). Use your hand to move it along the
surface of your desk; watch how the mouse pointer moves on the screen as ‘your hand moves the
mouse. Now pick the mouse up, put it down somewhere else, and move it again. As you can see,
the pointer doesn’t move when the mouse is in the air.

HMouse
Click On

Press down on the mouse button and release it.

Double Click

Press down on the mouse button, release it, press it again and release it. The two clicks must occur
very quickly, within 1éss than about a second.

Menu

Each item in the menu bar is the title of a menu. To see what choices are on a menu, move the mouse
pointer to a menu title, for example to the word Special, and then press and hold down the mouse
button. When you let go, the menu disappears. That way, you can look at what’s in a menu without
actually causing anything to happen.
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Select

To select an item under the menu title, move the mouse pointer to the desired menu title, keep the
mouse button pressed and move the mouse pointer to the desired item, and then release the mouse
button. That item is now selected. For practice, select Empty Trash from the Special menu:
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Notice how some items become highlighted as the mouse pointer passes them. Also notice how some
iterns are lighter than others, and are not highlighted when the mouse pointer touches them. These
are called “dimmed” items. They are dimmed because the Macintoshisnot able to do themrightnow,

and will not let you select them.

Ejecting a Diskette ‘
To remove a diskette from the Macintosh disk drive, select Eject from the File menu. If no diskettes
are inserted, the word Eject is dimmed and nothing happens. When you choose the Eject item, the
Mac pushes the diskette halfway out of its slot so you can pull it out the rest of the way.
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Open

Most icons have something interesting inside. To open an icon, move the mouse pointer to it without
pressing the mouse button. With the pointer touching the desired icon, “double click” the mouse
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button. Try this with the Trash icon; a rectangular “window” should appear. OK, there’s nothing
interesting in the Trash can, but it’s a good example because everybody should have one on their

screeil.
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You can close most icons by selecting Close or Quit from the File menu in the top menu bar. Close
the Trash icon now. Watch how the window retreats into its icon.
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The Desktop

The Macintosh screen is called the desktop. Using the Mac is supposed to belike working in an office.
The things you are working with are on your desk. These might be documents, folders full of

documents, various kinds of tools, and a trash can.
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Drag

You can arrange your desktop any way you like. You can line things up neatly in rows or put them
in messy piles, according to your work habits. Moving a desktop item is called “dragging”. To drag
an icon, move the mouse pointer to it without pressing the mouse button. When the pointer is
touching the icon, hold down the mouse button, move the mouse until the icon is in the desired spot,
and then let go. You can also drag an open window (like the open trash can) by its title bar. Open
the trash can icon again, move the mouse pointer to the “Trash” title bar on the top of the window,
hold down the mouse button and glide the window until you reach the desired place on your desktop.
Dragging is not justused for moving icons around. Itisused for copying information from one device
to another, discarding objects (by dragging them to the trash icon), and much more.

Dialog Box
Let’s look at the Special menu again. Do you see how one of the items, “Set Startup...”, ends with
three periods? :
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This notation means thatif you select that menu item, the Mac will display a “dialog box” asking you
for more information. Select this item now. You should see a box like this:
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There are two kinds of items in this dialog box: small circles, and the big enclosed words “Cancel”
and “OK”. The circles are called “radio buttons;” the enclosed words are just “buttons,” Each group
of radio buttons is like the row of buttons on a car radio; if you push one, all the others pop cut —
you can only select one station at a time, To push a button, move the mouse pointer to it and “click”
the mouse button: press it and then let go. One click is enough (two clicks are too many). This
procedure is called “clicking on”, as in “Don’t click on OK yet!”

If you have been having so much fun pushing radio buttons that you forgot how they were originally
set, you could confuse yourselfand your Mac, A well-designed dialog box always gives you (atleast)
two ways to conclude the dialog: “OK” means the Macintosh should make the indicated changes, and
“Cancel” means to ignore all of your mischief and do nothing. Click on Cancel.

Other dialog boxes, as you will soon see, present you with other ways of entering information.

Shuttin g Down Your Macinfosh
This is what you should do whenever you are finished using your Macintosh. It ensures that all your
information is safely tucked away for next time. If you have any diskettes inserted, they are ejected
automatically. Shut down your Mac by selecting Shut Down from the Special menu.
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Software Installation

The Mac Kermit diskette in the back of this book contains the executable Mac Kermit program on
a 3.5 inch diskette, readable by any Macintosh. Installing Mac Kermitis easy: justinsert the program
diskette into the diskette drive and copy the files.

What you will need

Before we go on, review the following checklist to make sure you have everything you need:

« A Macintosh computer, This computer can be a Mac Plus, Mac SE, Mac II, or any of the newer
Macintosh models. Any version of the Macintosh operating system, Finder, or Multifinder may

be used.
« Atleast 777 of available memory.
+ A working diskette drive.

+  The Kermit software on diskette (in the back of this book).

Backing Up Your Mac Kermit Diskette

Before you use Mac Kermit or any new software program, you should make a copy that you can work
with and put the original diskette away for emergencies. Some software is protected so you can not
copy it. Mac Kermit is not. You can make as many copies as you wart.

There are different ways to copy a Macintosh diskette, but there is only one way that works on all
Macintoshes, and that is the way that uses a single diskette drive. If you have two disketie drives,
or a diskette drive and a hard disk drive, and if you are familiar with Macintosh disk copying
techniques, you can use your favorite method to back up the Mac Kermit diskette. Otherwise, follow
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these directions:

1. Start Your Macintosh and if you have a diskette-only system, insert your system diskette into the
diskette drive.

2. If you have a diskette-only system, eject your system diskette after the Mac has started.

3. Make sure the write-lock window of your Mac Kermit diskette is open. The write-lock window
is located in the corner opposite the diagonally cut corner. If the window is closed, push the tab
up to open it. This is the “source diskette.” You want to keep it intact.

4. Getanunused diskette and make sure the write-lock window is closed so you can copy the source
diskette to it. This is the “target diskette.”
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6. The Mac Kermit disk icon will appear near the upper right hand corner of your screen. If it
doesn’t, you probably have a bad disk (get a replacement).
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7. Open the Mac Kermit disk icon by double-clicking on it, and a new window will open up. This
is called the “directory window”. It shows the diskette’s contents. You should see the Mac
Kermit program icon (a frog) some Mac Kermit startup files (a frog drawn on a dog-cared piece

of paper), and some other items:
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If you don’t see an arrangement like this, get a replacement diskette.
8. Close the Mac Kermit directory window by selecting Close from the File menu.

9. Eject the Mac Kermit diskette (move the mouse pointer to the word File on the menu bar, push’
the mouse button to open the File menu, move the mouse pointer to the word Eject, and let go).
The Mac Kermit diskette icon remains but has become dim, like a fading memory,
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10. Insert the target diskette into the diskette drive. If the diskette is truly a blank new diskette, it must
be initialized before you can use it; a dialog box will pop up telling you that the disk is unreadable
and asking if you want to initialize it. Go on to step 11.
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If the target disk was previously formatted, the dialog box willnot pop up. In that case you should
convince yourself that it’s OK to completely destroy and overwrite the contents of the second
disk. If it is not OK, eject it, find another target disk, and go back to the beginning of this step.
If it is OK, skip ahead to step 15.

11. Use the mouse button to click on either the One-Sided or Two-Sided button, depending on your
diskette drive.

12. A message will appear telling you that all the information on your disk will be erased. Don’t be
alarmed becduse this is a brand new diskette and there wasn’t any information on it yet. Click

on Erase.
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13. Another window pops up and asks you: “Please name this disk™. Use the Macintosh keyboard
(yes, the keyboard) to enter “Working Mac Kermit 1.07, and then press the Return key.
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14. The message changes to “Formatting disk...”, and busy whirring noises come out of the Magc for
a minute or two. Wait for the initialization to finish, and then you should see a new diskette icon
underneath the original Mac Kermit disk icon, with the title you have given.
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15. Use the mouse to point to the original Mac Kermit diskette icon. Keep the mouse button pressed
and drag the icon until it is on top of the “Working Mac Kermit 1.0” diskette icon. When the two
diskettes touch, the “Working” icon should become highlighted. Release the mouse button to

start copying.
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16. A dialog box pops up asking you if you are sure you want to replace the contents of the new disk
with the contents of the old disk. Read this message carefully to make sure you are copying in the
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ri ghf direction. If you are sure, click on OK and proceed to the next step. If not, click on Cancel
and go back to step 15.
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17. The“Working” disketie ejects and you are asked to insert the original Mac Kermit source diskette
into the diskette drive to be copied. Do as it says.

18. When the Mac has read as much of the source diskette as its memory can hold, it will eject the
source diskette and prompt you to insert the target “Working” diskette into the diskette drive, and
then it will copy the information from its memory to the target diskette.

If your Mac doesn’t have enough available memory to hold the entire contents of the source diskette,
it may ask you repeat steps 17 and 18 one or more times. '

19. When the copy process is complete, the dialog box disappears. Drag the dimmed Mac Kermit
1.0 (source diskette) icon to the Trash to make the Macintosh forget about it.
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20. Put the original Mac Kermit diskette in a safe place for disaster recovery.

Now let’s be sure that the newly copied diskette is usable. Double click on the Working Mac Kermit
1.0 diskette icon and make sure it looks like the original Kermit diskette directory window.

If you don’t see Kermit-like objects when you open the working diskette, or if you get some kind of
error message, eject the diskette and drag its icon into the frash can to remove it from your desktop.
Something has gone wrong with the backup process. Try it again with another target diskette.

Installing Mac Kermit on a Hard Disk Drive

If you do not have a hard disk drive, your installation of Mac Kermit is already complete, and you
can skip to the next section, To install Mac Kermit on a hard disk drive, follow these steps:

1. Start your Mac.
2. Insert the “Working” diskette into the diskette drive.
3. Drag the “Working” diskette icon to the hard disk icon.

4. A dialog box will appear saying that the two disks are not of the same type. Click on OK.

& Fils Edit Uiew Speclal Color

hayd disk BO [
Zitems 43,184K In 2isk 35,553 zvaibble herd disc 80

= f= }g [E0h )

System Fakler UEE: The Wwo dlsks are different lypes, so

ihe contanis of “ioerking Mac Kermit
1.0 will be placed in a (oldar on * hard
disk 80",

S

5. A“folder” called “Working Mac Kermit 1.0” will be created in your hard disk directory window.
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A folderis an icon thatcontains other icons, similarto a diskette icon. In fact, thenew Mac Kermit
folderhas exactly the same contents and title as the diskette it was copied from. If you open either
one of them, you should see the same things.,
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6. Drag the “Working Mac Kermit 1.0” diskette icon to the frash can. Let go of the mouse button
when the trash can becomes highlighted, The diskette will eject, its icon will disappear, and the
Mac will forget it ever existed.

7. Use the mouse to click twice on the new folder to open its directory window. Make sure you see
the Mac Kermit program and startup file icons. If you don’t, retrace your steps and fix whatever
went wrong.

You now have a Kermit folder installed on your hard disk drive. Close the Mac Kermit directory
window. Your Mac Kermit software installation is complete.
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Cables, Connectors, and Modems

Your Macintosh can be used to communicate beyond your deskiop but, like a telphone, only if it is
connected by some kind of cable to the outside world.

There are several ways to hook up your Mac for communication, Your connection can be direct to
another computer, or it can go through a data communication device like a modem, data phone,
multiplexer, or terminal server. You will need the following communication equipment:

+  An unused serial port on your Macintosh. This can be either the modem port or printer port.
« A modem {only if you will be using a telephone connection).

+ A data cable to connect your Mac’s serial port to the modem or whatever other device you plan
to connect it to..

The Data Cable

No matter what connection method you choose, you will need a data cable. Someday personal
computer users may be able to use the air waves but for now we need cables to carry our data from
one point to another. Look at the back of your Macintosh. If your Mac is right up against a wall like
mine, this task is not as simple as it sound; you may have to use your yoga techniques. You should
find several places to plug cables into, Two of themare the serial ports that Mac Kermit can use: the
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place with the picture of a telephone receiver is called the modem port; the place with the picture of
a printer is (you guessed it) the printer port.
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You can use Mac Kermit with either serial port, but the modem port is preferred because of
mysterious technical aspects of the Macintosh hardware (see your Macintosh Owner's Guide). For
simplicity, let’s refer to the port you will be using as the serial port. Your job is to get a cable that
connects the Mac’s serial port with whatever device you will be connecting the Mac to,

By the way, the 25-pin connector is not a serial port. Itis a Small Computer System Interface (SCSI),
used for connecting external disks and similar devices. Do not plug a serial communication cable

into the SCSI Port!

The Macintosh End

You might have played a game as a child to prepare you for this activity. Remember the one where
the object was to fit a figure, circle, star, square, into the correctly shaped hole? It’s the same
objective, only this time with cables and ports. Let’s see if you have mastered this'skill. Older
Macintosh computers have communication ports with 9-hole connectors called 9-pin female “D”
connectors, or DB-9s. Newer Macintosh computers, like the Mac Plus, Mac SE, and Mac II, have
eight holes inside a small circle, This is a female socket for a male Mini-8 connector. Naturally the
same cable will not fit both of types of Macintosh.

fpT G00.00,
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Plugging a DB-9 connector into the Mac is straightforward. There’s only one way it will fit. If the
DB-9 connector has screws, tighten them to prevent the cable from wiggling loose — a common
cause of data communication failures.

|
A
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The Mini-8 connector is a little more difficilt to manage. Because it is round, it’s not obvious how
to plug it in. If you have it turned the wrong way and push too hard, you can damage the pins. The
metal hood of the Mini-8 connector has threelittle grooves, which should be lined up with the grooves
on your Mac’s connector, Part of the connector hood is cut to be shorter than the rest. The short part
goes on the bottom, Once you’re sure you have the connector lined up correctly, push it straight in
as far as it will go. Be wary of cables that have rubber sleeves that extend too far, preventing the pins
from making complete contact. If this happens to you, get a better cable or you could try to whittle
the rubber sleeve away with a pocket knife.
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The Other End

The other end of your cable plugs into either the communication port of a nearby computer (possibly
with a little help from an adapter) or into the communication device you are using to contact more
distant computers. The connector for this end of your cable should normally be a male DB-25

connector.
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A cable with a 25-pin male connector on one end and a male DB-9 or Mini-8 on the other is called
a Macintosh modem cable. These are available from Apple Computer and from computer supply
houses. The Macintosh modem cable can be used to connect your Mac to most standard modems
(like Hayes), as well as to most other kinds of data communication equipment, including terminal
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servers, multiplexers, A/B or matrix switches, data-equipped digital telephones, and so forth.

A few companies sell modems that have other kinds of connectors. Such modems, especially those
that are marketed towards Macintosh users, come with their own Macintosh data cables, If such a

cable is supplied, use it instead.

OK, now you have the correct cable (if you don’t, stop reading, run to your local computer store, and
buy one). Plug it into the serial port on the the back of your Macintosh. Now you have one end of
the cable connected to the Mac and the other end dangling. Just as it should be at this stage of the
setup. The following sections explain what to do with the other end, depending on whether you have
a modem, a direct connection, or some other setup.

Modem Connections

You can use your voice telephone to make the connection to the computers and services you want
to use with the help of a modem. A modem is a device that converts the data that comes out of your
Macintosh serial portinto noises suitable for transmission over telephone lines, and converts modem-
generated telephone noises back into data. This lets you connect your Mac to any other computer
that is near a telephone and that also has a modem.
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If you don’t have a modem, you’ll have to get one. Modems can be purchased at computer stores
and from computer supply catalogs.
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It is usually a good idea to contact the proprietors of the computers or services you plan to use and
ask them what kind of modem you should get in order to communicate with them. Modem selection
is a complicated topic, beyond the scope of this book, but you should know that there are many
different “modem protocols” that ave not necessarily compatible with each other, and your modem
must support the same protocol as the modems attached to the computer or service you are calling.
You should also know that modems can transmit data at different speeds; in general, the higher the
speed, the higher the price. But if you pay for connect time, an expensive high-speed modem can
pay for itself.

If you must buy a modem, be sure to get a data cable with it. Specify that the cable must connect the
modem to a Macintosh, and specify which kind of data connector the Macintosh has (8 or 9 pins,
round or not). The modem should also be supplied with a standard modular telephone cord.

Hoceking Up Your Modem
If you’re using a modem, the data cable goes from your Mac’s communication port to the modem’s
data connector. Plugitinnow. If the connector has screws, tighten them,; this prevents the connector
from wiggling loose, which can cause static, interference, or broken connections.

Macintosh Modeim Cable (Hale DB~25)

The next part is a little tricky but once you have it set up correctly, you should not have to do it again
until you change your equipment, In order to use the modem, you must remove your telephone and
put the modem in its place. Unplug the modular cord that connects your telephone to the phone jack,
and plug it into the modem, where there is usually a modular receptacle marked “line” or “to line”.

Using Mac Kermit Page 25




# i A
Phone Jack

Modular
Fhone Cord

Unplug from here

Macintosh and plugin here
0
jﬂ Modem
e |

Data

Cable J
\.

Most modern modems also have a second modular receptacle marked “phone” or “to phone”. Use
a second modular phone cord to connect your telephone to this receptacle. This lets you use your
telephone in the normal way when you’re not using your modem tomake a data call (See your modem
manual for details),
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Modular telephone cords can be found in hardware stores or supermarkets in the USA. An extra
modular phone cord is supplied with most modems. Connection methods and regulations pertaining
to modems may vary in other countries.
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Other Communication Devices

Most other communication devices, including data-equipped digital phones, terminal servers,
multiplexers, data switches, etc, are like modems. If they conform to the standards that apply to data
communication equipment, they should have 25-pin female D connectors, so you can plug your Mac
modem cable right in,
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Hacintosh

Data Cable
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If yourorganization has its own wiring scheme, forexample special “data jacks” in each office, you’ll
have to contact your data communications group to find out how to connect your Mac to it.

Direct Connections

You can connect your Macintosh directly to another computer as long as it is within about 50 feet
or 15 meters of your Mac. You can use the same Macintosh modem cable you would use with a
modem but you need one more attachment, called a “modem eliminator” or “null modem adapter™,
A computer’s communication port is designed to be connected to a modem, not to another computer.
Certain wires within the cable must be crossed if two computers are to be connected directly, and that
is what the modem eliminator does; it tricks the two computers into believing they are talking thru
modems,

Female-Female DB~25

Modem Eliminator (bent)
., "y
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To connect your Macintosh directly to another computer, plug the appropriate type of modem cable
into the other computer’s communication port, and then join it to your Mac modem cable (already
connected to your Mac) with a 25-pin female-female modem eliminator.
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There are other possible cable combinations too. When two computers are very close together, you
could use a single cable if the connectors on each end match the computer ports and the cable is a
modem eliminator. If you do not have a modem eliminator cable, you can add a modem elimninator
adapter to your single modem cable. If you have all the right cables but the wrong gender to fit into
place, you could get a “gender changer” to change the pins from male to female or vice versa. A
gender changer looks just like a modem eliminator, but the wiring inside is different.

When the two devices are farther apart than your cables reach, you can use one or more male-female
DB-25 modem cables as data extension cords as long as the total distance does not exceed 50 feet
or 15 meters.

Use your ingenuity! Just make sure that only one cable or adapter is a modem eliminator otherwise
they will cancel each other out and you will have a modem cable again.

Modem cables, modem eliminator adapters, and gender changers are available in most computer
stores and supply catalogs. You should be able to find them in male-female, male-male, and female-

female models.
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Controlling Mac Kermit

Mac Kermit is installed, your Mac is connected to a modem, another computer, or some other
communication device with the appropriate kind of cable, and you’re almost ready to start
communicating, Let’s begin with the basics of controlling the program - starting it, stopping it, and

accessing its menus.

Starting Mac Kermit

If you have a diskette-only system, insert the Working Mac Kermit diskette and open it (move the
mouse pointer to it and double click on it). If you have a hard disk, open the Mac Kermit folder.
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Now move the mouse pointer to the icon named Mac Kermit 1.0 — the one with a frog staring ata
fly. This is the standard Mac Kermit executable program. It has no customizations.

Start Mac Kermit just as you would start any Macintosh application: double~click on its icon. (Did
you sce the frog’s tongue snatch the fly?)

The Mac Kermit Screen

When Mac Kermit starts up, it replaces the Macintosh Finder’s menu bar at the top of the screen with
its own menu bar, Some of the menu items are the same, like File and Edit, and the other menu items

are different,
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Mac Kermit’s window is a terminal emulation screen. Whenever this window is the foremost
window on your Mac screen, your keystrokes are sent out the currently selected communication port
through the cable connected to it. The characters that come into the port through the cable are
displayed on your screen. But if you are not connected to anything, your keystrokes accomplish
nothing —- like using a typewriter with no paper.

If you move the mouse pointer to the menu bar at the top of the screen, you can pull down any of Mac
Kermit’s menus. Look at the items beneath the Log menu title, for example. These are the options

you may choose from,
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Notice that your mouse movements and pressing the keys on your keyboard will affect any menu or
dialog box that overlays the terminal window.

Across the top of the Mac Kermit window, below the menu bar, is a “title bar” containing horizontal
lines with the name of the open application in the center — in this case, Mac Kermit. You can

reposition the Kermit window by dragging its title bar.
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A vertical “scroll bar” is located on the right edge of the terminal window. This is Kermit’s “time
machine”, Itlets you move backwards and forwards in your terminal session, Thisis a handy feature
for viewing text that has already scrolled off your screen.

In the lower right corner of the Mac Kermit window is a small square superimposed over a larger
square, Thisis the “size box” that controls how big the terminal emulation window is on your screen.
To change the size of Mac Kermit’s window, move the mouse pointer to the size box, hold down the
button, move the mouse until the window is the desired size and shape, then release the button.

Ending a Mac Kermit Session

You should always learn how to start and stop an application before you actually use it. You know
how to start Mac Kermit (double click on the program icon). When you are finished with it, move
the mouse pointer to the File menu in Mac Kermit’s menu bar, hold the mouse button down, then
select the Quit option by moving the mouse pointer to that item and releasing the mouse button. Mac
Kermit shrinks back into its icon in the Working Mac Kermit directory window,
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You can also use the keyboard to exit Mac Kermit: hold down the Command key (the key near the
space bar that has a picture of an Apple and/or a four-leaf clover) and press the Qkey simultancousty.
This is “keyboard equivalent” for the the File menu Exit selection, and it is shown in the File menu
as Command-Q. Keyboard equivalents are not available on old Macintosh keyboards that do not

have a Control key.

You can disable keyboard equivalent commands in case they interfere with other aspects of your
Macintosh environment: Just go the Settings menu and select Menu Keys Active. If there is a check
mark, selecting this item will remove it and turn off the menu keys feature; if there is no check mark,
selecting this item will turn the feature back on,
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You can even tell Mac Kermit to start another Macintosh application when it exits by selecting
“Transfer to App..” from the File menu, rather than Quit. This causes a directory dialog box to pop
up in which you can select the application you want to start.

Using Mac Kermit with MultiFinder

If you have MultiFinder installed as as the startup application on your disk, you can switch back and
forth between Mac Kermit and other applications using any of these methods:

+  While in Mac Kermit, move the mouse pointer to the Apple menu in the top menu bar and then
press the mouse button. A menu will appear, divided into several sections. Near the bottom is
a list of all your currently active applications., One of them is Mac Kermit (with a check next to
it, because it is the current application) and another one is Finder. With the mouse button held
down, move the pointer to Finder and then let go. Your Kermit window will go to the back, and
your previous directory window will come to the front. Now you can start another application.
You can also select any other application from this list.
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+ If you can see any part of a window sticking out from behind Mac Kermit’s window, move the
mouse pointer to it and click once to get back into that window.,

+ If you see a directory window containing the dimmed icon of another application, you can get
into the corresponding window by double-clicking on the dimmed icon.
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+ At the extreme right of the top menu bar is a tiny icon of the current application. If you click on
it repeatedly, MultiFinder cycles through all of its currently active applications, one per click,
until you land in the one you'’re looking for.

If you bring another application to the front under MultiFinder, it takes control of the keyboard and
mouse, but the terminal window remains active for receipt and display of characters coming in
through the communication port and onto your screen,

For further information on Macintosh windows, Finder, and MultiFinder, read your Macintosh System
Software User's Guide.

Creating and Using Mac Kermit Documents

When you open your Kermit disk or folder icon, you will see some Mac Kermit “documents.” Mac
Kermit document icons look like words printed on dog-eared pieces of paper. These icons are small
files containing various collections of Mac Kermit communication, file, terminal emulation,
keyboard, and Kermit protocol settings appropriate for different kinds of connections.
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If you double-click on one of these, Mac Kermit starts automatically with the selected settings. These
custom settings may be referred to as initialization files, settings files, or startup files— all mean the

same thing.

At any point in a Mac Kermit session, you can go to the File menu and select “Save Settings...” to
copy all your current settings into a Mac Kermit settings file and give it a name.
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Select the “Save Settings” item now. This will be a good way for you to learn about the Macintosh
directory dialog box, which is used for opening or creating files.
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On top is the “directory title box™, containing the icon and name of the current disk or folder. If you
want to open or create a file in a different folder, treat the directory title like a menu: move the mouse
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pointer to it, hold down the button, and select any other folder shown in the menu.

The larger box, called the “directory contents box”, contains a list of the contents of the current disk
or folder whose name is shown in the directory title box. This box has a scroll bar to let youn view
items thatdon’tfit, If you select a folder fromthis list by double clicking ont, it becomes your current
folder, its name appears in the title box, and its contents appear in the contents box.

To the right is the name of the current disk device, and below it are buttons marked Eject and Drive.
If you have more than one disk active, you can click on the Drive button to switch among them, If
you have a diskette inserted, you can eject it by clicking on the Eject button, and then you can insert
another diskette and select it with the Drive button. Using the directory title box, the contents box,
and the Drive and Eject buttons, you can save your file in any folder on any disk.

Because you are creating a new file, you must also choose aname forit. Atthe bottomof the directory
dialog box is a text box marked “Save variables in file:”. A default name is filled in for you already,
butif you press any key(s) on the keyboard, the defaultname disappears and you can type anew name.

Once you have chosen the desired name and selected the desired disk and folder, you can create your
settings file by clicking the Save button, or by pressing the Return key on yourkeyboard. If the name
you have chosen is the same as the name of an existing file, an “Alert Box” pops up, which gives you
a choice of overwriting the existing file (click on “Yes”) or going back to the directory dialog box
and choosing a new name (click on “No”).
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Not only can you start Mac Kermit from a settings file, you can also load settings from any Mac
Kermit settings file after Mac Kermit has started, Select “Load Settings...” from Mac Kermit’s File
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menu and you’ll get another directory dialog box, similar to the “Save Settings...” box, but without
a text box for the filename. This because Mac Kermit is looking for a file that already exists, so there
is no need for you to invent a new name. Just find the file you want to load your settings from and
double-click on its name,

* &I edit Settings Font Remote Log Print
Mac Kermit
K3
[&Mac Kermit 1.0]

0 Even-1208 - B (E] Mac Karml..,

D Even-2400

D Evsn-9600 '

0y IBM-Full-1200 5

0 {BM-Full-2400

D [BM-Full-9608 g —

0 I1EM-LIne~1200 - _m

0 IBM-Line-2400 ||

0 10M-Line-9600 3 o
N A

Using Mac Kermit Page 37




Page 38 Controlting Mac Kermit




Preparing to Communicate

Computers—even Macintoshes— arenot nearly as conforming as people. People can almost always
communicate with each other atleaston a basic level, even when they don’t speak the same language.
Computers, however, are far more rigid. They require that other computers speak exactly the same
language, at exactly the same speed, and follow specific rules of etiquette that determine which
computer may speak at a specified time. Otherwise there is no communication at all.

Computers can not interact until they are physically connected to each other and set up to follow the
same communication rules. But this cannot happen unless the two computers have some knowledge
of each other and their connection, which they could communicate to each other if only they were
connected! Luckily, we humans are able toresolve this paradox by instructing our compuiers in each
detail of the communication environment, Qur instructions are conveyed to Mac Kermit through its

Settings menu.
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Communication Settings

Move the mouse pointer to Mac Kermit’s Settings menu, and select “Communications...”. A dialog
box pops up: '
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You don’t have to be a data communications expert to cope with Mac Kermit’s communication
settings, Youreally don’teven have to know what they mean. You just have to set each item tomatch
the computer or service you are trying to contact. You probably have a tip sheet telling you how to
set up your communications software. Just follow it, and you should be ready for business.

Baud Rate

Here you see a bunch of numbers with radio buttons. These numbers represent the transmission speed
to be used by your Mac’s serial port, in bits per second (bps), sometimes called “Baud rate”. The most
common baud rates are 1200 and 2400 (used with modems) and 9600 and 19200 (used with direct
connections, terminal servers, multiplexers, etc), Some newer {and more expensive) modems are
also capable of higher speeds like 9600 or 19200, If you are dialing out with amodem, use the highest
speed supported by your modem. If you have a direct connection, use whatever speed it is set up for.
‘This is & very important setting. If Mac Kermit is not instructed to use the same transmission speed
as the computer or service at the other end, or the speed you have chosen is not supported by your
modem, communication can not take place at all.

Parity/Bits

The “Parity/Bits” selection tells Kermit whether to use 8 bits or 7 bits per character. The Macintosh
stores characters in 8-bit “bytes,” so you should use 8-bit communication if possible. In some cases,
the other computer or service, or the communication path between it and your Mac, does not support
8-bit communication. Instead, 7 data bits and one “parity bit” are used for each character, There are
five possible types of parity: even, odd, mark, space, and none. Click on the appropriate type, which
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should be specified in the documentation for the computer or service you are connecting to.

Every computer, service, and connection method is potentially different, so there can beno universal
guidelines about parity. But here are a few hints, For any type of connection to an IBM mainframe,
even or mark parity is usually required. Formost connections that go over public data networks, mark
or space parity is required. For most connections that go through TCP/IP terminal servers, telnet, or
rlogin connections, space parity is required, Most direct or dialed connections to UNIX and VAX/
VMS systems can be made with the parity set to “None/8”.

If your terminal screen has a mixture of strange-looking and correct-looking characters on it, try
changing the parity setting. Parity becomes more important during file transfer.

Some dialup services or bulletin boards instruct you about how many “start bits” and “stop bits” youn
should use. Modemn equipment (meaning practically any terminal, PC, computer, or modem
manufactured in the past 20 years) does not bother about this, and neither does Mac Kermit. You
can safely ignore all references to start and stop bits. :

Similarly, yourinstructions might include areference to “data bits”. Here, there are only two choices:
7 and 8. You get 8 automatically if you select “None/8”, and you get 7 if you select anything else
in the “Parity/Bits” section. If your instructions tell you to use 7 data bits with no parity, select
“Space/7”. There is no way to have 8 data bits and parity at the same time:

Serial Port
This is the most important setting of all. Youmust tell Mac Kermit which serial port your data cable
is connected to: modem or printer. If you have hooked up the printer port but Mac Kermit uses the
modem port, or vice versa, there will be no communication at all. If you try using the printer port
when it is connected to Appletalk, you will get an appropriate error message.
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Modem Control
The square box marked “Drop DTR on Quit” tells Mac Kermit whether to hang up the phone when
you exit from the program. This setting is only effective with dialup modems or other data
communication equipment that works like a modem.

DTR is an abbreviation for Data Terminal Ready, This is the name of the signal sent by the Mac to
the modem on one of the wires in the data cable. It tells the modem that the computer is alive and
communicating. If this signal is turned off, most modems hang up the phone. Unless you tell Mac
Kermit otherwise, the phone call is left active when you quit from the program so you can run other
applications on your Mac, then start Kermit again and continue to use your connection. If you want
Mac Kermit to hang up the phone when you quit, click on this box.

The square boxes in a dialog window, like the one just before “Drop DTR on Quit” are called “check
boxes”. Checkboxes are different from radio buttons. In a group of radio buttons, only one may be
“pushed”. Check boxes, on the other hand, are independent of each other., Clicking on an empty
check box makes an X appear, and clicking on a check box with an X in it makes the X disappear.
An X in the box means the corresponding feature is selected.

Flow Control
“Xon/Xoff” flow control refers to a kind of pacing that two computers use on each other to prevent
data from being sent faster by one of them than the other one can keep up with. It works greatif both
computers know how to do it, but it will cause problems when one computer does it and the other
doesn’t. To avoid this kind of trouble, Mac Kermit doesn’t try to do it unless you ask it to. Click
on this box if you are communicating with a VAX/VMS computer, a UNIX computer, or an IBM
mainframe in “full screen” mode. If you are communicating with an IBM mainframe in linemode,
leave this box unchecked. For other computers or services, check their documentation.

When you have selected all the appropriate communication settings, click on the OK box.

Terminal Settings

Your next step is to prepare Mac Kermit for a terminal session with the computer or service you will
be using, Once again, move the mouse pointer fo the word Settings on the menu bar at the top of the
screen and push the mouse button, Drag the mouse cursor down to the word “Terminal...” and release
the mouse button. The Terminal Settings dialog box appears.
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The arrangement of check boxes in the figure shows the terminal settings you get by default. Click
on any box to add or remove the X, Let’s look briefly at Mac Kermit’s terminal settings.

Auto LF with CR
Automatic Linefeed with Carriage Return. If this option is selected, Mac Kermit transmits a carriage
return (CR) and a linefeed (LF) whenever you press the Return key, Normally, only CR is transmitted
when you press CR. It is rarely necessary to-select this option,

Auto Repeat Keys
This tells whether Mac Kermit should transmit multiple copies of a character as long as you hold
down the corresponding key. If you select this feature, the rate at which the key repeats itself and
the length of time before it starts repeating can be modifed (even while Kermit is active) by selecting
Control Panel from the Apple menu, and then selecting Keyboard from the Control Panel,

Auto Wrap around

"This tells Mac Kermit what to do if the remote computer or service sends a line of text that is wider
than your terminal screen. Wrap around means to display the extra characters on the next line, If
you uncheck this box, excess characters overwrite the character on the right screen margin. Some
computer systems, like VAX/VMS or IBM mainframes in full screen mode, want tohave full control
of the appearance of your screen, and take responsibility for wrapping themselves. Others, like
UNIX, rely on the terminal or emulator (like Mac Kermit) to take care of wrapping. It’s usually best
to leave this box checked.

Block Cursor
This specifies the shape of the terminal cursor — the little blob that shows your current position on
the terminal screen (not to be confused with the mouse pointer). Normally it is a large rectangular
block, big enough to fully cover a character. If you uncheck this box, the cursor becomes a small
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underline beneath the current position. This setting is strictly a matter of taste.

Blinking Cursor
This says whether the terminal cursor should blink — normally desirable to help you find it on the
screen, Again, this is your preference.

Inverted Screen
This means to display light characters on a dark background. When this box is unchecked, Mac
Kermitdisplays dark characters on alight background. Try both ways to see which is more appealing
to you.

Lines on the screen
This tells Mac Kermit how many lines of text are to be displayed on the screen. The default is 24,
like a real VT-100, -200, or -300 terminal. Most host computer applications that format the screen
of a VT-series terminal expect it to have 24 lines, so you should change the length of Kermit’s
emulation screen only if you are also able to tell the host computer what your new screen length is.
This is not a check box, but a “text box”. If you want to change the number of lines on the terminal
screen, use the keyboard to type a different number, from 1 to 99,

Local Echo :
This one tells Mac Kermit whether to display the characters you type on the keyboard itself, or to et
the remote computer or service doit. Check this box when communicating with a remote computer,
such as an IBM mainframe in linemode, that requires the terminal to do its own echoing. If the
characters you type do not appear on the screen, but the characters sent by the remote computer do
appear, you should check this box. On the other hand, if you see two copies of each character you
type, remove the X from this box. '

Smooth S crolling

Check this box to select “smooth™ rather than “jump” scrolling. Smooth scrolling is easier on the
eyes, but a lot harder on your Mac. The Mac will definitely have trouble keeping up with computers
that display a lot of scrolling data on the screen at high transmission speeds unless Xon/Xoff flow
control (see Communication Settings) is in effect and working on both ends.

Symbolic Control Chars

~Check this box to have Mac Kermit display arriving control characters in symbolic format (small
two-letter symbols, like CR for carriage return, LF for Iinefeed) rather than interpreting them as
screen formatting commands, This is useful for tracking down problems

Visible Bell
Check this box to make Mac Kermit flash its screen momentarily whenever a bell character arrives,
rather than making a noise. This feature is particularly useful for deaf Mac users.
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Accept Eight Bit Characters
This tells Mac Kermit what to do if its parity setting is “None/8” and an 8-bit character arrives.
Normally, Mac Kermit assumes that you forgot to check a 7-bit parity option in the Communications
Settings dialog box, and so it discards the 8th bit before displaying the character. If you are really
using an 8-bit character set, check this box.

Mouse -> Arrow Keys
This item tells Mac Kermit how to treat mouse actions that occur in the terminal window. Checking
this box makes mouse clicks in the terminal window simulate VT terminal arrow keys. Unchecking
this box lets you use the mouse for copying and pasting material to/from the terminal screen. These
options are discussed in the Terminal Emulation chapter.

Resetting the Terminal Emulator
The terminal settings described above do not take effect until you click on “OK” in the bottom right
of the terminal settings box. If you click on “Cancel,” no settings are changed. In both cases, the
terminal settings box goes away and you’re back in the Mac Kermit terminal window.

The “Reset Terminal” item is not a setting at all, but an action that occurs immediately when you click
onit. Itclears the screen, puts the cursor in the upper left corner, and puts the terminal into a normal
and sensible state, but does not change any settings and does not exit the dialog box. Use this to clear
up any confusion in your terminal display that might have been caused (for example) by communi-

cation line noise,
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Mac Kermit Startup Documents

Mac Kermit is distributed with a collection of prepared startup documents that cover most common
kinds of connections. If you start Kermit by double-clicking on one of these documents, it saves you
the bother of going through the settings menus each time you run the program, and in many cases,
of constructing your own startup documents. Each startup file occupies about 2K on your Mac
Kermit diskette.

Speed Parity/Bits Flow Handshake Fcho Delete

Normal-9600 9600 None/8 Xon/Xoff Nene Remote DEL
Normal-2400 2400 None/8 Xon/Xoff Nene Remote DEL
Normal-1200 1200 None/8 Xon/Xoff None Remote DEL
Even-9600 9600 Even/7 Xon/Xoff None Remote DEL
Even~2400 2400 Even/7 Xon/Xoff None Remote  DEL
Even-1200 1200 Even/7 Xon/Xoff None Remote DEL
Mark-9600 9600 Mark/7 Xon/%off None Remote DEL
Mark-2400 2400 Mark/1 Xon/Xoff None Remote DEL
Mark-1200 1200 Mazk/7 Xon/Xoff None Remcte  DEL
Space—~9600 9600 Space/7  Xon/Xoff None Remcte  DEL
Space—-2400 2400 Space/7 Xon/Xoff None Remote DEL
Space—-1200 1200 Space/7  Xon/Xoff None Remote  DEL

IBM-Full-3600 3600 Even/7 Xon/Xoff None Remcte  BS
" IBM-Fulil-2400 8600 Even/7 Xon/Xoff None Remote  BS
IBM-Fall-1200 3600 Even/7 Xon/%off None Remote BS

IBM-Line-9600 9600 Mark/7 Nene Xon Local BS
IBM-Line-2400 2400 Maxk/7 None Xon Local BS
IBM~Line~1200 1200 Wark/7 None Xon Local BS

All of these startup files use the modem port. Each filename ends with its transmission speed. In
general, 9600 is used for direct connections and 2400 or 1200 is used for dialup connections,
depending on the maximum that your modem and the modem you are calling have in common (but
modems capable of higher speeds are becoming more common). The Parity/Bits and Flow columns
correspond the Mac Kermit communication settings. Handshake is a file transfer protocol setting
(discussed later). Bcho refers to the Local Echo box in the Terminal settings menu, The Delete
column tells whether the Macintosh Delete key sends delete (DEL) or backspace (BS). If it sends
DEL, then Shift-Delete sends BS, and vice versa.

The Normal startups are for most common types of connections, both direct and dialed, in which the
remote computer or service allows two-way simultaneous (full duplex) connection and echoes your
keystrokes as you type them. The Even, Mark, and Space startups are identical to the corresponding
normal ones, except using the type of parity indicated. The IBM startups are for connections to IBM
mainframe computers.

Youcan easily modify any of these settings files: start Mac Kermit from the desired startup file, make
any necessary changes to the settings, and then select “Save Settings...” from Mac Kermit’s file
menu. You can also discard the settings files you don’t need to save space on your hard disk or
working Mac Kermit diskette by dragging theiricons to the trash can and selecting the “Empty Trash”
item in the Special menu.
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If you will be communicating through the printer port rather than the modem port, you should modify
each startup file that you plan to use before going on to the next chapter: Check the “printer” radio
button in the “Serial port” section of the Communications Settings menu.
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Terminal Emulation

You need some way to communicate with a computer that is not physically on your desktop. The
way this was accomplished before personal computers became so popular was with a terminal. A
terminal is just a communicating typewriter, consisting of a keyboard for data entry, a paper printer
or a television screen for display, and a serial port for communicating. It peforms no functions by
itself except to connect you to a computer so you can carry on adialog with it. APClike the Macintosh
can do a lot on its own, but when you want to use it to contact another computer, it must act like

(emulate) a terminal.

As you now know, when you double click on Mac Kermit’s little frog icon, a terminal emulation
screen jumps out at you. Whenever this screen is up front, Mac Kermit is in “terminal mode”. The
term “‘mode” is used a lot in computer manuals. It usually has something to do with how a computer
program interprets yourkeystrokes (or mouse actions). “Terminal emulation mode” means thateach
character you type is sent out the serial port and each character that arrives at the serial port is

displayed on your screen.

When you pull down a menu or when a dialog or alert box pops up, Mac Kermit’s terminal window
is overlaid by another window and Mac Kermit goes into “command mode”. Your keystrokes and
mouse actions affect the foremost window and are interpreted as commands rather than as keystrokes
to be sent to the other computer.
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Making Contact — The Data Connection
Once you are in terminal mode, you can make an actual connection. Ifyou have a Hayes-like dialout ’

modem, follow these steps to communicate with a remote computer or service. For direct
connections, only step 1 is required.

1. Start Mac Kermit from the appropriate startup file.

2. Make sure the transmission speed (baud rate) is appropriate for your modem, Ifitisn’t, getinto
the Communication Settings menu and change the speed, for example to 1200 or 2400.

3. Make sure your modem is connected with the appropriate type of cable to the Macintosh serial
port that Mac Kermit has been told to use. Also, make sure the modem is turned on and in data

mode (see your modem manual).

4. Type AT (uppercase) and then press the Return key. The modem should respond with “OK” or
the digit “0” (zero). Ifit doesn’t, check the cables and the modem (consult your modem manual

for details).

5. Nowtype ATDT 7654321 and then press the Returnkey, butreplace 7654321 by the actual phone
number you are calling, and replace ATDT by ATDP if you have a rotary (pulse dial) phone
instead of a Touch-Tone model.

6. Ifyourmodem has aspeaker you should hear the dialtone, the dialing and the other phoneringing.
If the connection succeeds, you’ll get a message like CONNECT (or the digit “1”), otherwise
you'll see an error message like NO CARRIER, BUSY, NO ANSWER, or a digit like 3 or 4 (see
your modem manual), in which case you should try again later.

7. If the modem prints a message like CONNECT 1200 to indicate a transmission speed that is
different from the one Mac Kermit is set to, this means your modem negotiated a different speed
with the other modem. If your modem does “speed matching”, ignore the message. Otherwise
get into the communications settings dialog box, click on the indicated speed, and return to the
terminal screen before you type any characters.

For non-Hayes-compatible modems or other kinds of communication devices (terminal servers, data
phones, etc), follow the appropriate directions in the manual supplied with it.

You have just used your Macintosh as a terminal to talk with your modem. It sent the characters you
typed to the modem’s built-in command processor and displayed the modem’s responses on your
screen. Youtyped “ATDT 7654321 and then pressed the Return key. Mac Kermitsenteach of these
characters to the modem. The modem not only read and interpreted them but also sent them back
to the Mac, and Mac Kermit displayed. them on your screen, '

Now we getto ourfinal destination— the other computer. After the modem has made the connection,
it takes itself out of the picture, Its command processor disappears and it sends each character it
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receives from the Mac to the other computer and vice versa, In other words, the modem has gone
out of “command mode” and into “transparent mode”. Mac Kermit itself doesn’tknow a thing about
this — it has been in terminal mode all along.

Using the Connection

Now you can communicate directly with the remote computer or service. A login prompt will appear
on your screen when the connection is made (you might have to press the Return key one or more
times to make this happen). Sometimes an intermediate device (like a data switch or terminal server)
will appear first and you will have to select which computer or service you want.

Let’s look at how to connect the Macintosh to some popular computers.

UNIX

Start Mac Kermit from one of the “Normal” startup files, for example Normal-1200. If you are using
a modem, dial the number for the remote computer. Once the connection is made, UNIX notices that
you have arrived and prints its greeting and prompt automatically. If not, press the Return key on
your keyboard one or more times until you see a greeting. Then type your user name in response to
the “login:” prompt and your password in response to the “Password:” prompt. In the following
example screen, you type the words that are underlined and then press the Return key at the place
where the underline ends. ’
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login: gal
Password:

$
$ date
$ Ved Dec 6 20:35:27 EST (930

Your password does not echo. The dollar sign is a typical UNIX system prompt, but different
computers may have other prompts. In response to the UNIX prompt you can type any UNIX
command. Remember you are talking to the UNIX computer as if it were right there on your desk.
Ask UNIX the date and time, forexample — just type “date” and press Return. Whenyou are finished
using UNIX, you should “log out”. The command for logging out varies among UNIX systems, but
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it is usually either “exit” or “logout” or Ctzl-D (hold down the Control key and press the letter D).
If you have dialed up the UNIX computer with amodem, UNIX will automatically hang up the phone
connection when you log out, and if your modem is a Hayes or compatible, it will report NO
CARRIER when the connection is broken. '

VAX/VMS

Start Mac Kermit from one of the “Normal” startup files and make the connection like we did in the
above UNIX example. Press the return key once or twice to get the computer’s attention, Again, the
password doesn’t echo. The dollar sign is the normal VMS prompt. Now it’s asif you havea VAX/
VMS computer on your desk. When you are finished using VMS, type the command LOGOUT and
then press the Return key.
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IBM Mainframes

IBM mainframes running operating systems like MVS/TSO and VM/CMS can be accessed from
Mac Kermit in one of two ways: full screen mode (through a 3270 protocol emulation front end) or
linemode.

For full screen connection, start Mac Kermit from the “IBM-Full” startup file for the appropnatc
transmission speed and make the connection as in the previous examples.

The protocol converter must know how to convert the mainframe’s 3270 formatting commands for
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Mac Kermit’s screen, so you must tell it what kind of terminal Mac Kermit is emulating. Most
protocol converters support VT-100 terminals, and so does Mac Kermit, so this is a good choice. The
method varies; here is an example with the IBM 7171 protocol converter.
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In response to the ENTER TERMINAL TYPE prompt, press the Return key to see a list of valid
terminal types and get a new prompt. In response to the new prompt, type “vt-100” and press the
returnkey. At this point, you should see a full-screen logo that contains a prompt for your username
(or “userid”) and password, and in the lower right corner a word describing what (yes) “mode” the
terminal is in: RUNNING, HOLDING, VM READ; etc.
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When the screen fills up, it says “MORE...”, and you must type a special character or sequence to
proceed to the next screen, Unfortunately, this sequence varies from place to place (try Control-L).
To log in, the usual procedure is to type your username, then press the Tab key, then type your
password (which does not echo), and finally press the Returnkey. The coramand to log outis usually

LOGOUT.

For a linemode connection to an IBM mainframe, start Mac Kermit from one of the “IBM-Line”
startup files.

Procedures for logging in vary, but in general you should begin by pressing the return key and then
supplying your username and password in response to the prompts. Because a linemode connection
to the mainframe requires local echoing, your password will appear on the screen when you type it.
Make sure nobody is watching!
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Dialup Information Services

Dialup information services like Compuserve, Dow Jones News/Retrieval, Genie, MCI Mail, and so
on, as well as most bulletin boards, can usually be accessed using the Normal startup files. If you
have trouble, try a Mark or Even startup file. Most of these services require you to supply a username
and a password, and then give you a selection menu — sometimes using VT-100 style screen

formatting,
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If you are connected to the remote host or service with a dialup modem, it should hang up the phone
connection automatically when you log out. If it does not, you can hang it up from Mac Kermit’s

Edit menu by selecting Toggle DTR from the Edit menu.
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Characteristics of Mac Kermit’s Terminal Emulator:

Mac Kermit emulates most features of the Digital Equipment Corporation terminal. Its tcrmmal
emulator can therefore be used effectively with any computer that supports VT-100, VT-200, or VT-
300 series text terminals, These include most UNIX-based operating systems, all DEC operating
systems (such as VAX/VMS), and most IBM mainframe 3270 protocol converters. You should
identify your terminal type to the computer or service you are using as VT320, VT300, VT220,
VT200, VT102, or VT100, in that order of preference (the highest one it understands), using
whatever method is provided by your host or service.

You might not appreciate all the niceties of a good terminal emulator unless they weren’t there for
you. Mac Kermit’s emulator offers a wide variety features that can be controlled by the computer
or service itis connected to. “Escape sequences” (special combinations of characters) are sent to Mac
Kermit by the host computer or application to position the cursor to any spot on the screen, clear the
screen or selected portions of it, display characters with different kinds of emphasis (like boldface,
underline, or blinking), divide the screen into separate scrolling regions, display line-drawing
graphics, insert and delete lines or characters, and much more,

Mac Kermit’s Special Tricks

Your Macintosh is much more than just a terminal — it’s a powerful general-purpose computer. And
so it can do things for you that ordinary terminals cannot. Let’s look at a few of them,

Changing the Screen Font
Mac Kermit uses a 9-point VT100 font (typeface) which was specially designed to simulate the
appearance of the characters of a real VT100 terminal, Even the VT100’s special characters are
included. The VT100 font is a “monospace” typeface. This means that all characters are the same
width so screen material lines up as it does on a real terminal. This is the font that is shown in the
example terminal screens you have already seen.

If you prefer a different typeface or a different type size, you can make changes in Mac Kermit’s
screen font from the Font menu. The first section shows the available sizes, ranging from 7 to 18
points. When you select a different font size, Mac Kermit changes the size of its terminal window
to fit. But watch out — certain combinations might not fit on your screen if your Mac has a small
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monitor.,

The second section lists the available fonts. The contents of the list depends on what fonts you have
loaded on your Macintosh. Cairo, Chicago, Courier, Geneva, New York, and a few others are
generally available to choose from. Courier is a monospace font like VT100 and works well in
terminal emulation, but like all regular Macintosh fonts it lacks the VT-100 special graphics

characters.
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The other fonts are proportionally-spaced. This means thatletters have different widths (“m” is wider
than “i”), Mac Kermitdisplays each character left-adjusted in a fixed width box, however, so screen

data for most fonts lines up correctly even if it might look a little strange.
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Moving the Terminal Emulation Window

Even while Kermit is active, you can arrange your Macintosh screen so that it suits you. If you want
the Kermit window to be in a different place on your screen, you can move it by dragging the
horizontal title bar at the top. If a desk accessory (or any other application under MultiFinder)
overlays the emulation window, the emulation window can be clicked upon to move it to the front.
Then you can drag it where you want it. Be careful not to drag the terminal window while characters
are arriving or data might be lost.

Sizing the Terminal Emulation Window

The terminal screen can be lengthened or shortened in the Terminal Settings dialog box, or by
dragging the size box in the lower right corner of the texrminal screen, If you make the terminal screen
anything other than 24 lines, host applications that expect to format or edit your screen can become
quite confused. On the other hand, if you can inform the remote computer or application about your
new screen size, it might be able to make good use of it. For example, in VAX/VMS you can use
the command SET TERMINAL /PAGE=35 to tell VMS how many lines you have on your screen,
and applications like TYPE/PAGE, EDIT/TPU, and GNU EMACS will take advantage of the larger
size, Other applications (like EDT and PHONE) might not.

In most UNIX versions you can give a command like “stty rows 35” to achieve the same effect, and
then screen-oriented applications like GNU EMACS and “more” should adapt to your new screen
size. IBM 3270 protocol converters do not let you change the number of lines on your screen during
a session, and most of them only allow for 24-line screens.

Screen Rollback

You can use the vertical scroll bar on the right edge of the terminal window to view text that has
scrolled off the screen. The scroll bar has an up-arrow at the top, a down-arrow at the bottom, and
if any text has scrolled off the screen, it also has a square box somewhere between the arrows.

If you click on the up-arrow, the terminal screen rolls back a few lines, Clicking on the down-arrow
rolls it forward several lines. Clicking above the square box makes it roll back about half a screen.
Clicking below the square box makes it roll forward by a similar amount. You can also drag the
square box to make the screen roll back or forward to a particular spot.

If text arrives while you have the screen rolled back, the screen jumps forward to its correct position
before the text is displayed.
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Recording Your Session
During terminal emulation, the characters displayed on the screen can also be saved on the disk. This
allows you to record interactions with the remote computer or service. You can use this feature
“capture” entire files if, for some strange reason, the remote system does not have a Kermit program.
Use the Log menu, and select “Session...” to activate this feature, You’ll get a directory dialog box
to let you choose a file in which to record your session.

Session

000008C4 EHACS TRA4 HIE 4 Sloz | DUmp 2(rena to Sa4skm
000004B ERREHT HIB 7 7644 Transactions
' Packats
00060047 OPCOM HIB 8 348 0 00:00:03. €8 347
00060048 AUDIT_SERVER  HIE 10 4% 0 00:00:03.07 1328
00000049 JOB_CONTROL  HIB 8 12082 0 00:01:33,12 141
00000048 CONFIGURE HIB 8 € 0 00:00:00,31 6
00000048 RETACP HIE 10 10009 0 09:08:02.21 448
0008004E EVL HIR 6 1844 0 00:01:20.04 215089
00000040 REMACP HIB 8 18 6 00:00:00.17 73
00000052 SYMBIGNT_0001  HIB 8 186 0 00:00:02,35 250
00000083 IP_ACP(vVG.4Y  HIB 7 276507 0 G0:29:24,93 8924
00000064 NRHSRY HIR 7 620 0 00:00:04,64 247
A J
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To turn off session logging, enter the Log menu again. Notice that Session is now checked, to show
that the session log is active. Click on session to close the session log and uncheck the Session item,

i £ File Edit Settings Font Remote ARLIPE7ING h
Ee——————==——— Normal-24vSession
00000804 EHACS TRA% HIE 4 aigz | Dump screen to sessian lag
00000048 ERRFMT )41 7 7644 Transactions
} Packels
DODOON47 OPCON HIB 8 349 0 00:00:03.88 347 119
00000048 AUDIT_SERVER  HIB 10 44 0 00:00:03.07 i328 282
20900043 JOB_CONTROL HIB 9 12082 0 $0:01:33,12 141 36
00000044 CORF IGURE HIB 2 6 0 00:00:00,31 35 144
00000048 NETACP HIB W 10008 0 00:09:02.21 448 BB7
000C004C EVL HIB 5} 1544 0 00:01:20.04 215089 47
0000004 REHACP HIB ] 18 0 00:00:00.17 73 47
00006052 SYHBIONT.OGO1  HIB & 1686 0 50:00:02,35 250 140
00000053 IP.ACP(YS, 4>  HIB 7 276307 0 00:28:24,93 024 278
G0000054 NAKSRY HIB 4 B20 0 00:00:04,54 247 382 HRY

A

Using the Mouse

There are two ways you can use the mouse in your terminal window, but you can only use one way
ata time. If you have selected the “Mouse -> Arrow Keys” terminal setting, the mouse pointer turns
into a small rectangle when itis in the terminal window. Whenever you press the mouse button Mac
Kermit transmits the codes that would have been sent by a VT100-type terminal if you had pressed
its arrow keys in the right sequence to move the terminal cursor from its current position to where
the mouseis. This feature can be used with full-screen applications on VAX/VMS computers, IBM
mainframes in full-screen mode via 3270 protocol converters, or any other applications that accept
VT terminal arrow key codes as cursor movement commands.

If you have not selected “Mouse -> Arrow Keys”, the mouse pointer appears as an “I-Beam”, You
can then use it with the Macintosh’s text editing features and the Copy and Paste selections in the Edit

menu.
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Copying And Pasting Text to and from the Terminal Screen

To copy text from your terminal screen to the clipboard, hold down the mouse button, move the
mouse to highlight the desired text, thenlet go of the mouse button, go the edit menu, and select Copy.
You can paste the copied material into any other application thathas an Edit menu with a Paste option.
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You can also paste material from other applications (including Mac Kermit itself) into Mac Kermit’s
terminal window in the same way. For example, you can paste text from Mac Write into a text editor
on the host computer. Whenever you paste into the Mac Kermit window, the text you have pasted
is sent out the communication port as if you had typed it yourself,

Another handy application of the copy and paste feature is to reissue previous commands to the
remote computer. Justroll your terminal window back, find the command you want toreissue, select
it, copy it, and paste it.

Other Tools in the Edit Menu

The second part of the Edit menu gives you some special communication tools. “Send BREAK”
sends a BREAK signal, “Send Long BREAK” sends a long BREAK signal. BREAK signals are
required by certain mainframes, port contention units, or multiplexers to get their attention, and are
used by some UNIX systems for transmission speed adjustment during the initial connection process.

“Send Xon” transmits an Xon (Control-Q) character. Do this when your terminal session appears
to be stuck — this might unstick it.

“Toggle DTR” really means “hang up the phone”. If your connection to the other computer was
dialed through a modem, and your modem s configured to pay attention to the DTR signal from Mac
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Kermit, and your data cable passes this signal correctly to the modem, clicking on this option should
hang up the phone call.

Printer Control

(*** none yet; notice the dimmed Print selection in the main menu bar... ¥*%¥)

The Keyboard

The Macintosh keys labeled with letters, digits, and punctuation marks send the characters they are
labeled with, the space bar sends a space, the Tabkey sends a tab, and the Return key sends a carriage
return. These keys are called “normal keys”.

O 0000 D004 OOoo aoo [

SENNSNERERRERRC 000 adc
ONNNNENERSNREO 000 O00d
CONERNERREEEESO_] aaaa
CESEEENEEREC T O 000
DO OOc ooo 4
\ J

All Macintosh keyboards since the original 128K Macintosh also have a built-in numeric keypad too.
Thekeypad keys send the same special escape sequencesasaDEC VT-series terminal in “application
mode”. The top row of the keypad corresponds to the DEC VT100 keys PF1 through PF4, PF1 (the
Num Lock or Clear key on your keyboard) is also called the “Gold key” in certain DEC applications.

4 ' ~
O OO0C0O 0000 O04acz Odo ]

2 |
COoO0DOO000CcOc 000 SREe
N
COOoopoonoooc— O
OO0 OO0 000 NSNEN
/
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The Apple Extended Keyboard has a row of function keys labeled F1 through F15 across the top.
These are considered normal keys, They do nothing unless you define them.

s ™

O RV O

OOoooooooouno/] 0oo oooo
(0 o O [
N [ gOao
- [Onoooooooooc/ O 00d
| OO | N | | oy i

\_ J

The Apple Extended keyboard also has a “special keys” group between the main keypad and the
numeric keypad. The special keys include arrow keys, page up, page down, home, end, del, and help
keys. The arrow keys send the same escape sequences as the VT100 arrow keys, and the others send
various control codes.

O 0000 0odo 0004 ooy O

Oonogoooonoooc4i ooas
N 000 o oooo
{0 T | HiNEE
I o o 000
I | A | N | | /0

Modifier Keys

The Macintosh keyboard also has “modifier keys” called Shift, Caps Lock, Control, Option, and
Command, These keys do nothing by themselves. But when they are pressed simultaneously with
a normal key, a new character is sent. For example, if you press the “A” key, a lowercase letter a is
sent. If you hold down Shift, then press the “A™ key with it, an uppercase letter A is sent.

The Shift Key

The Shift key affects all letter keys and function keys. Italso affects the other normal keys that have
two symbols printed on the keycap. With Shift held down, the key sends the top symbol, otherwise
it sends the bottom symbol, When used with keypad keys, Shift causes the key to send the character
that appears on the keycap instead of the special VT terminal escape sequence.
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The Caps Lock Key
The Caps Lock key affects only letters. This key locks into place when you press it and then pops
up when you press it again, When Caps lock is down, all letters are sent in upper case, regardless
of whether any Shift keys are also pressed.

The Control Key
The normal, Shift, and Caps Lock keys work just like on a typewriter, and can be used to produce
about 95 different printable characters, including space. But computers also have “control charac-
ters”. Some control characters, like carriage return and tab, affect the appearance of the normal
characters on your screen, and others are used strictly for controlling computer programs or devices.

Computer terminals have a key labeled Control or Ctrl. It operates like a shift key, but instead of
producing a normal character, it produces a control character. For example, if you hold down the
Control key, then press the A key with it, a character called Control-A is produced.

If your Macintosh has a Control key, Kermit uses it just like the Control key on a terminal or PC. If
your Mac does not have a Control key, Mac Kermit uses the Command key as the Control key. The
Command key can not be used for keyboard equivalents of menu selections in this case.

The terminal emulator sends ESC (escape) when the ¢ (accent grave) key is pressed unshifted (even
if your keyboard has an ESC key), because the grave key is where most computer users expect the
ESC key to be. The accent grave character itself can be sent by holding down the Control (or
Command) key and pressing the accent grave key.

Unless you have started Mac Kermit with an IBM-Line or IBM-Full startup file, the Backspace or
Delete key sends a Delete (Rubout) and Shift-Delete sends a backspace. The IBM startup files
reverse this: Delete sends backspace and Shift-Delete sends Delete.

On the original Mac keyboards, the main keypad Enter key sends a “short” (250ms) BREAK signal.
Newer Macintosh models do not have a main keypad Enter key. The BREAK signal can be sent from
any Macintosh model by selecting “Send Break” from the Edit menu (which also lets you select a
“long BREAK”), or on Macs that have a Control key, by typing Command-B (hold down the
Command key and press B).
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Character Sets
Letters, digits, punctuation marks, and control characters are represented inside the computer by
numbers, Each character has its own unique number. The characters understood by the computer,
along with the numbers that represent them, is called a “character set”. The character set most
commonly used is calted ASCII (American Standard Code for Information Interchange). Itincludes
128 characters: 95 “graphic” (printable) characters (including space) and 33 control characters, Here
is the complete ASCII character set: '

The US ASCII Character Set (ANSI X3.4-1977)

Dec Oct Name Ctrl | Dec Oct | Dec Oct | Dec Cct
¢ 00 NUL “@ ! 32 40 sp | 64 100 8 | 96 140
01 SOH ~A | 33 41 ! | 65 101 A | 97 141 a
2 02 ST™ B | 34 42 " | 66 102 B | 98 142 b
3 03 ETX ~C | 35 43 # | 67 103 c | 99 143 ¢
4 04 EOT -“D ] 36 44 5 | 68 104 D ] 100 144 d
5 05 ENQ “E [ 37 45 % | 69 105 E | 101 145 e
6 06 ACK *F [ 38 48 & | 70 106 F | 102 146 £
7 07 BEL *G [ 39 47 N | 71 107 G | 103 147 g
8 1¢ BS "H backspace | 40 50 { i 72 110 H | 104 150 h
9 11 HT ~I tab | 41 51 H | 73 111 I | 105 151 i
10 12 IF AJ linefeed | 42 52 * | 74 112 J | 106 152 4
11 13 VI “K ] 43 53 + | 7% 113 K | 107 153 k
12 14 FF 2L formfeed | 44 54 ’ i 16 114 L I 108 154 1
13 15 CR “M return ] 45 5% - | 771 115 M [ 109 155 m
14 16 80 *N ] 46 56 . | 78 116 N | 110 156 n
i5 17 s8I A0 | 47 57 / | 79 117 0 [ 111 157 o
16 20 DLE P | 48 60 0 | 80 120 P | 112 160 p
17 21 DCl ~Q XON | 49 81 1 | 81 121 o | 113 16l g
18 22 DC2 "R I 50 e2 2 | 82 122 R | 114 162 «x
19 23 DC3 ~5 XOFF | 51 863 3 | 83 123 8 | 115 163 =
20 24 DC4 AT | 52 64 4 ] 84 124 T | 116 164 ©
21 25 NARK ~U | 53 65 5 | 85 125 u ] 117 165 u
23 27 ETB "W | 54 66 6 | 86 126 V | 118 166 v
22 26 SYN ~V | 5% 67 7 | 87 127 W | 119 167 w
24 30 CAN ~X | 56 70 8 | 88 130 X | 120 170 x
25 31 EM Y { 57 71 9 } 89 131 Y | 121 171 ¥
26 32 SUB "2 | 58 72 : | 90 132 Z o122 172 =
27 33 ESC “[ escape { 59 13 : I 91 133 [ | 123 173 {
28 34 FS M\ | 60 74 < | 92 134 \ | 124 174 |
29 35 G5 A~} ] 61 75 = | 93 135 ] 125 175 }
30 36 RS [ 82 76 > | 94 136 ~ ] 126 176 ~
31 37 ©s [ 63 77 2 ] 95 137 _ | 127 177 RUB

This table shows each character, plus its decimal numeric value (Dec), its “octal” (base 8) numeric
value (Oct), and the character itself. Control characters are in the first colurnn (0-31). Since confrol
characters have no graphic appearance, names are shown instead along with the key combinations
used to generate them. For example, the character SOH is generated by holding down Cirl and
pressing A, so it is also called Control-A, which is shown in the table as “AA”, The last character in
the table is also a control character, called RUB, short for Rubout (sometimes also called Delete). All
the others (32-126) are printable graphic characters, which are shown literally in the table.
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Reconfiguring the Keyboard
You can modify the behavior and configuration of the keyboard any way youlike, You canmake any
key send any single character or, for that matter, any sequence of characters. You can even change
the way the Control, Command, and other modifier keys behave, These modifications are effective
only when Mac Kermit’s terminal emulation window is active — they don’t affect other Macintosh
applications.

Only one normal key can be pressed at a time, but one or more modifier keys can be pressed down
along with it, When you press akey or key combination, Mac Kermit knows exactly which keys you
pressed and looks up that combination in its key definition table. Then it makes any substitution you
might have requested, and finally sends the result out the communication port.

If no substitution is defined, but one or more of the modifier keys was pressed when you typed your
character, Mac Kermit looks in its modifier table to see how it should modify the character you typed,
and then sends the result. :

Defining Key Macros
A character or a sequence of characters assigned to a key is called a “key macro”, “Macro” is a
conmputer word that means something small that is used to stand for something else, usually bigger.
To define a key macro, select “Set Key Macros...” from the Settings menu. A dialog box appears,
asking you to “press the key to program”.

(2 File rdit JEIIIEEY Font Remole log srnt B
Normal-2400

[

Press the key to program

O

X | )

If you had to type the name “Peter Piper” many times each day, you could assign that name to the
key F1, for example. You could assign Shift I¥1 to be “Mary Mack”, Option F1 to be “Sarah Lee”,

and so on.
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Press the desired key (including any combination of modifiers). A new dialog box appears, with an

editable text box in it.

© & Fie Edit ESUINEY Font Semote Log Print A
Normal-2406
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Enter the definition for the key here. Your definition can be up to 255 characterslong, and caninclude

any character at all, including control characters, 8-bit international characters, etc.
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Characters that you can’t type directly, such as Ctrl-C, can be included in the macro definition by
entering a\ (backslash), followed by 3 octal (base 8) digits for the value from the ASCII table. For
example, an ASCIINUL (value 0) would be written as\000, Ctrl-C (ASCII 3) would be\003, carriage
return (ASCII 13) would be written \015 (1 x 8 + 5 =13). Also, control characters may be entered
with a backslash, followed by a caret (or circumnflex, A), followed by the corresponding letter (upper
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or lower case). Thus a Control-G (value 7) could be entered as\007, \*G, or\g. Toinclude a literal
backslash in a definition, enter two of them; \\,

BREAK signals are also programmable as macros. BREAK is not a character, but a kind of gap on
the communication line that is much bigger than the legal size for a character. Some computers or
devices are programmed to detect BREAK signals and use them for special purposes, like
interrupting a program. If the entire macro string is *\break”, then pressing the programmed key
sends a short (1/4 second) BREAK. A long (3.5 second) BREAK is defined with “\longbreak”, A
macro can define either a BREAK, or a string of normal characters, but not both.

Defining Key Modifiers .

A common problem faced by computer users who switch from one terminal or PC to another is the
placement of the modifiers and other special keys. Mac Kermit allows you to assign any of various
functions to any of the Mac’s modifier keys so you can tailor the layout of your Mac’s keyboard to
suit your typing habits. For example, most experienced computer users like to have the Control key
just left of the A key, where it was located on most keyboards until the mid-to-late 1980s, For some
reason, keyboard designers decided it to move it out of reach and put Caps Lock in its place. You
will find this arrangement, for example, on the newest IBM and Apple “extended” keyboards. The
“Set Modifiers...” option from Mac Kermit’s Settings menu lets you put the control key back where
it belongs. ' ' '

To change the action of any of the modifier keys, select “Set Modifiers...” from the Settings menu.
A dialog box appears:
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The check boxes are divided into rows. Bach row describing a modification, The left half of each
row has a box for each modifierkey. A checked box on the left side means that when this key is down,
do whatitsayson the right side. Rows with nothing checked on the left side are ignored; the character
is modified in the normal Macintosh way.
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The right half describes what modification to do to the characters. The Unmodify modification says
“make this character the one that would be sent from the same key with no modifer keys pressed”.
The Caps modification translates all letters to upper case but does not affect other characters. Cirl
makes the letter into the corresponding contol character (if any). Meta sets the high-order (8th) bit
on the character (but only if parity is None) and if a Prefix string is given at the end of the same row,
it is sent before the character is.

Hints about modifiers
+ Beware of the Option key. It changes the value of any characters you use withit. If you type
Option-F, the Mac will send a D, if you type Option-D, the Mac will send a 6, etc. If you want
to use the option key as a modifier, be sure to check the “Unmodify” box.

+ If youassign a modifier function to the Command key, or if you assign macros to Command-key
combinations, you should also uncheck the “Menu Command-Keys Active” item in the Settings
menu. Otherwise, the Command-key menu equivalents will take precedence over your
definitions.

+  When interpreting a keystoke, Mac Kermit checks the list of modifiers from top to bottom,
applying the first one that matches. For example, if you want a different modifier for Command-
Option and just plain Command, you must put the definition for Command-Option firstin the list,

Features for People with Disabilities

The Macintosh is easier to use than most computers for people with certain kinds of disabilities. For
example, people with certain physical impairments and find it easier to use a mouse than a keyboard
to issue commands to the computer.

Keyboard Tricks
Mac Kermit’s terminal emulation, however, requires you fo use the keyboard to enter characters to
be sent to the remote computer or service. This task can be especially difficult if you have difficulty
holding down more than one key at a time (normally required for generating control or uppercase
characters)., There are two solutions to this problem,

First, you can use Mac Kermit key macros to assign difficult key combinations or commonly typed
character strings to single keys, such as the otherwise unused function keys.

Second, with recent releases of the Macintosh operating system, you can use the “sticky keys”
feature, If there is a folder called Easy Access in your System folder, you can use this feature to enter
modified characters by first pressing the modifier key and then pressing the key to be modifed, rather
than pressing them both at once. To turn on the sticky-keys feature, press the Shift key five times
without moving the mouse. When the feature is on, a tiny icon appears at the right of your top menu
bar. To turn it off, press the shift key five times in a row again. The sticky key feature only works
for one modifier at a time.
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Mouse Alternatives

If you have difficulty controlling the mouse cursor directly with the mouse, you can use the numeric
keypad instead if you have Easy Access in your system folder. To turn on the “mouse keys” feature,
press the Command, Shift, and Clear kcys'at the same time (you could use a key macro to define a
single key to do this). In “mouse keys mode” the digit keys on the numeric keypad can be used to
move the mouse pointer, and the 5 key in the middle can be used as the mouse button. The Okey locks
down the mouse button for dragging, and the period key unlocks it. For further information about
Easy Access, see your Macintosh System Software User’s Guide. '

Watich the Bell

Deaf users can use Mac Kermit in the normal way, except they cannot hear any bell (beep) characters
sent by the remote computer or service, You can tell Mac Kermit to flash its screen when a bell
character arrives instead of making a noise by checking the “visual bell” box in the terminal settings
ment.

Enlarging the Display

Users with visual impairments can use Mac Kermit’s font menu to select a larger font size, or they
can use the CloseView utility that comes with the Apple system software. The CloseView icon (a
magnifying glass) must be placed into the System folder. When CloseView is active, the mouse
pointer is surrounded by a rectangular frame. If you hold down the Option and Command keys and
press the X key, the contents of the frame expands to fill the whole screen and you can use the mouse
to look at other parts of the screen. Entering the same key sequence againreturns the screen to normal
size. The amount of magnification and other aspects of CloseView can be changed by selecting
Control Panel from the Apple menu, and then clicking on the CloseView icon. For further
information, read the section on CloseView in your Macintosh Utilites User’s Guide.
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Transferring Files

Now that you have used your Macintosh to interact with other computers, you are almost ready to
transfer files between your (local) Mac and another (remote) computer. Mac Kermit will transferany
file that you request — to or from the Macintosh. But for a file to be useful after the transfer, you
have to know a little bit about the file. Then you can relay this information to the Kermit program

on each computer.,

Macintosh Files

A file is a collection of data stored on a computer disk, Each file is identified by a name that
distinguishes it from other files. On a Macintosh disk, files are stored like papers in a filing cabinet.
They can be directly on the disk’s “desktop” or placed inside “folders” for better organization.
Folders can even contain other folders with files in them, Theresult is a hierarchy of folders and files.
Apple calls this structure the “Hierarchical File System” (HES).

| Disk |
Volume

Foldar Fiie j Folder

Folger Flle

Fite Flle File

Fila Folder
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Files are generally required to have unique names, but files in different folders can have the same
name.

File Names

Macintosh file and folder names may be up to 31 characters long, and may contain any printable
character, including space and punctuation. Colon (:) is the exception to this rule. A colon may not
be used in the name of a file or folder because it is used internally by the Macintosh operating system,
Any mixture of upper and lower case may be used when creating a file name, and the case is preserved

in the file's icon.

However, case is ignored by the Macintosh when looking up a file by name. This means that you
cannot have two files in the same folder (or on the same desktop) whose names differ only in their
capitalization. For example, the names “O0FA” and “Oofa” refer to the same Macintosh file.

File Structure

Macintosh files are quite different from files on other computers because they come in two pieces,
or what Apple calls “forks” — the data fork and the resource fork. The data fork contains data for
an application, The resource fork generally contains menus, icons, dialog boxes, font information,
and the executable code of an application. A MacWrite document, for example, contains text and
formatting information in the data fork and fonts in the resource fork,

( A Macintosh Flle A MacWrite File A
Directory Entry Directory Entry
Name Chapter 8
Length 34275
Date Dec 20, 1990 10:28 AM
Location on disk 12345678

N ZN

Resource Fork DataFork Resource Fork Data Fork
Manus Data for Fonts Text and
|cons AppHcation Formatting
Dialog Boxes
Fonts
Application Code
. v,

File Formats

Every Macintosh application has its own peculiar, and often different, set of formats for data. Even
different releases of the same application may use different file formats. This can be a problem when
you want to transfer data between the Mac and some other kind of computer. The problem s solved
if the application gives you a way (usually an option in its File Save dialog box) to convert its data
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into a format suitable for transportation.

The format of each file can be seen by selecting “by Name” from the View menu on the Finder’s menu
bar. This makes the open window show a list of files with their sizes, formats (marked “Kind”), and
creation dates (marked “Last Modifed”).

& ritle cait JIISTN Soecial Color h
by Small Icon
by lcon
BilEe—————————§ [:1]] =
Hame Slze Kind Last Madified
[ 201 .slide 2K Microsoft word d... Mon, May 22, 1982 333 FPM {_}_
[0 Angry Letters -~ foMer Tue,Dec 11,1990 7O08PM
[} Another Book B3K PageMaker 4.0 do... Mon, Dee 3,1990 444 PM
) Boring Spresdshest 23K Excel 104 decument Thy, Jun 28, 1950  11:34 AM
[} danresume 17K HMaovrited.6 docu.,, Mon,Deo 33,1990 Z00FM
& 2o Kermit 1.0 120K applioation Fri,06126,1990  10:56 &M
&y Microsoft Word 351K application Thu, Apr 6, 1989 723 P
[ unix Settings ZK MaoKermit 1.0d.. Fri,0e126,1990 11:15 AM {—}-
<al [oAih)
\ J

Executable programs are “applications”. The other files are “documents”. A document may be
associated with a particular application. In the example, “a01.slide” is a document associated with
the application “Microsoft Word”. If you click on a01.slide, Microsoft Word starts automatically
with this document in its edit window. Most other applications will not be able to use the document
at all.

Files Types — Text versus Binary

The distinction between text and binary files is very important when transferring files with Kermit,
but can be difficult to determine on the Macintosh. In general, a text file is one that you can create
from the keyboard. It consists of only printable graphic characters and simple format-related control
characters (like carriage return and tab). A binary file, on the other hand, is usually created directly
by a computer program for use by a specific kind of computer application or device. Binary files
created by a particular kind of computer are usually only useful on that type of computer.

When transferring files with Kermit, you must decide whether a file is to be treated as text or binary.
To Kermit, “text”” means that the file should be converted to a form that is useful on the receiving
computer, “Binary” means that no conversions of any kind should be performed on the data.
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Let the user beware; the looks of a file can be decciving. VYery few Macintosh applications work on
plain text files. You might think you are working with text, but your file may actually contain
Macintosh-specific codes indicating font, typesize, and style that would be meaningless to another

kind of computer.

So, how can you transfer Macintosh files that are full of Macintosh-specific information and
therefore binary, to another kind of computer and actually use them there? The answer lies in the
Macintosh applications themselves. There are two methods for you to choose from: conversion to
a text-only format, and conversion to an interchange format.

Text-Only Format
Many Macintosh applications, including most of those that work on text, give you a way to save your
data in “text-only” format by clicking a special box or button in their file-save dialog boxes. For
example, MacWrite gives you two options: “Entire Document” or “Text Only”. The text-only option
saves only the characters themselves, and removes all Macintosh-specific information, such as fonts,
styles, icons, etc, Text-only files should be transferred with Mac Kermit in “text mode”.

"r_émtdlt Search Formol Fon! Styte 2:11
adl.slide
A Y ST 14 189 4 16, AN B ]
£ Y x A v~ —
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0 all) sfhfe i} L
0 a06.sllde
[} agd0.slide 2
FIRST INTERN| |p (amec g
0 frenthdut &
MOSCOW Y 5qe Current Bocument A < hard ..,
al,sfide
MONDAY, MAY
[ Save | [[Cancel ] [ Prive ]

Q Entira Document @ Text Only

TUESDAY, MAV 7 7
) Operation k I

WEDNESDAY, MAY 31: Workshop

[] Discussion of international Character Set Extension

- Presentations from other attendees ]

Interchange Formats for Similar Applications
Word processors, desktop publishing packages, data bases, spreadsheets, statistical packages, and
other applications often have versions available for different kinds of computers (like the Macintosh,
the IBM PC family, UNIX, VAX/VMS, and/or IBM mainframe). Each version of the package can
provide an “interchange format” so the same data can be used on a different kind of computer that
has the same application. For example, a spreadsheet can be created on a PC and then used on a
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Macintosh,

The method for saving a file in interchange format varies from application to application, but it
usually involves a special box or button in the “save” dialog box marked “export”, “interchange”,
or “format”. For example, Microsoft Word on the Macintosh includes a “File format” button in its
save dialog, When you click this button, you’ll see a list of formats that includes “Microsoft Word
(MS-DOS)”. If you click this button before saving, the file can be ransferred to 2 PC and used in
the MS-DOS version of Microsoft Word without losing any special effects — font, boldface, italics,

underline, etc.

(€ Edit Search Format Font Document Window ‘
a05.slide
|5! Waor - I
Fite Format

£y adit.msins O Normal

[ af1.sfide O) Teut Only

‘.'} "gﬁf'“m": O Teut Only with Line Breaks

g A O Microsoft Word 1.0

b i (also Microsoft Works)

Save Current Docum)| | @ Microsoft Werd (MS-DOS}
Iaﬂﬁ.slide (O Maclrite k
(]¥ast snoe (] Makd O Interchange format (RTF)

| (Fite Format...} {Cancel] [ Br}vﬁ?

Similarly, Microsoft’s Excel spreadsheet application for the Macintosh has an “Options” button in
its Save dialog, Clicking on Options reveals a selection of spreadsheet interchange formats: SYLK,
DIF, Text, WKS, and so on.
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Interchange Formats for Unlike Applications
Some applications include export/import procedures for other types of applications. You can save
a spreadsheet in a format designed for import into a database or a word processing program, or a
database can create a file for use by a statistical package. For example, Excel can save spreadsheets
in certain database (DBF) formats that can be imported to a database on the Macintosh or on another
type of computer with database software that understands these formats.

It’s up to you to find the appropriate format and method for saving your Macintosh file to make it
useful for the intended application on the receiving computer. Read the manuals for the two
application programs to find out which interchange formats they have in common.

No general guidelines can be given for whether to transfer an interchange-format file in text mode
or binary mode. You should experiment on small sample files., Try a binary-mode transfer first, and
then try text mode if binary doesn’t work,

Macintosh-to-Macintosh
Macintosh Kermit can be used to transfer any file at all between two Macintoshes, or, for that matter,
from a Macintosh to an intermediate computer for storage, and then later to another Macintosh. The

method used is called “MacBinary mode”.

When you transfer afile in MacBinary mode, itis almost as if the file was given to you on 2 Macintosh
diskette. All the file’s information is included: both forks of the file plus the directory entry, ina
special encoded form. When the file appears on the receiving Macintosh, it has both forks, its fonts,
" and all other information identical to the original file, and its icon appears automatically on your

SCIren.
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When you transfer a file in MacBinary mode to a computer other than a Macintosh, it is simply stored
in its 8-bit MacBinary encoded form. It cannot be used on that computer, but it can be transferred
to another Macintosh at a later time. Be sure to tell the sending program to use binary mode and the
receiving Mac Kermit program to use MacBinary mode.

Pre- and Postprocessing
*#%% Talk about BinHex, why and how... ¥**

Transferring Files

Once you know how to prepare Macintosh files for transfer, you are finally ready to transfer them.
Here are the basics for Kermit file transfer:

1.

Start Mac Kermit using a startup file that is appropriate for your connection, or start Mac Kermit
“bare”. Make any necessary adjustments to the communications and terminal settings.

Make the connection to the remote computer or service, for example by dialing it up with a
modem,

Identify yourself to the remote computer or service (“log in”),
Start the remote computer’s Kermit program. |

If you are sending a file from the Macintosh, tell the remote Kermit to “receive”. If you are
sending a file to the Macintosh, tell the remote Kermit to “send” the desired file.

If you are sending a file from the Macintosh, select “send” from Mac Kermit’s File menu, and
then choose the file to send. If you are sending to the Macintosh, select “receive”.

Watch the file transfer display that overlays your terminal screen. When it disappears, the file
transfer is complete.

When you are finished using the remote computer or service, log out or otherwise disconnect
from it.

Select “Quit” from Mac Kermit’s File menu to exit from Mac Kermit.
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Sending a File

Let’s work through a complete example in which we connect to a VAX/VYMS computerusing aHayes
modem and send a MacWrite text file to it. Begin by opening your “Working Mac Kermit 1.0” folder
or diskette, where you will find a short MacWrite file entitled “sample.mw”. It looks like this:

=

f— & Fila Edit Search Format Font Style

L{%mmpmmw
i. - TS N 1 T Iy .‘i}

@ Osmeinen = =) =] B E) G B

Mac Kermit Sample Taxt

-

This Is & somple MacwWrite text document to be transterred by Mac Kermit,
Up above you see o large bold heedline, which is also in a different font
from the rest of the document.

In this paragraph we have baldfoce, /Pe/ics, undertined texy, and various
combinations

Can you use Mac Kermit Lo Wrensfer this file o anoether kind of computer?

O
4]

\. v

The creator of this file included all sorts of special effects — fonts, type styles, and so on. These will
be useless on the VAX computer, so they must be removed. Do you remember how to strip a
MacWrite file down to its bare essentials? Double-click on this file to start MacWrite, then select
“Save As” from the File menu to get a dialog box like this:

(" <GEREdit Search Formal Fond Style

sample.mw
[ T A T = = ]
| 16 linas/in €4 Ch 08 - Rfer 3
0y Cg-uferpm-t 2]

Mac Kermit § | osererdoc

I} fucel-Save-Soio
This s a sample Hacr| [y Fite-Forks

Up abova you see a larg £ BFS-Dingram
from the rest of the do

saue Eurrent Document Ris e hard ...

In this paragraph ve hy .

7

Cen you use ec Kermid (" Sawe ) { Coneel § [ Drive |

@® Entire Document O Text Only

Move the mouse pointer to “Text Only” and click. All the special effects will be removed.

Page 78 . Transferring Files




Now notice how the filename is darkened. This means you can type a new name for the file into the
text box. Do this now. Type “sample.txt” and then press the Returnkey. This makesanew file called
“sample.txt” without overwriting the original file, “sample.mw”.

Sy it sesch Formot Font Stgle

sample.mw
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O Entire Document @kTenl Oniy
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Now quit from MacWrite (select Quit from the File menu). Your text file is ready to be transferred.

The next step is to start Mac Kermit with the appropriate settings. Let’s assume you have a 2400 bps
Hayes modem that gives you an 8-bit transparent connection to the VAX (parity = None/8). This
corresponds to the settings in Mac Kermit’s Normal-2400 startup file, so you can start Mac Kermit
simply by double-clicking on this startup file. Of course, you should use the startup file that is
appropriate for your own connection.

For this demonstration, you are using Tone (rather than Pulse) dialing, and the phone number that
you wish to dial is 555-1234. Once connected, you log in to the VAX, start Kermit there, and tell
it to receive a file. The following screen shows the entire procedure. As usual, the parts you type
are underlined, and you should terminate each underlined part by pressing the Return key.
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Password:

% kernit
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Now VAX Kermit is waiting for a file. Your next job is to tell Mac Kermit the name of the file to
send, Use the mouse to select Send File from the File menu, or use the keyboard shortcut (Command-
S). '

& Edit Settings Font Remote Log Print N
Load Setlings..., acKermnit==S————————————
AT Saue Settings... .
oK
e Get file from server.. %6
Send file... %S
Yelef “Raceive file... %R

useri' Transfer sfats...
Passi gat transfar directory...

¥ ke
ke Transfer to App... %7
Type| Quit 910

C-Kernitreceive
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A Macintosh directory dialog box will appear on your screen.

[ "—.;‘ Edit Settings Font Remote Log #£rint
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@® Tent @® Data

O binary { Resource

{O MacBinary

[[]15end all files of the eurrent folder
. J

Now you can choose the file you want to send. To send our sample file, move the mouse pointer to
the file name “sample.txt”. If you don’t see it, search through the file list with the scroll bar or type

the first few characters of the file’s name,

With “sample.txt” highlighted, observe the dialog box. You'll see that Mac Kermithas automatically
decided to send the data fork in text mode. That is because it is not a application. Mac Kermit also
converted the file’s name to uppercase for transfer purposes (lowercase names sometimes confuse

other kinds of computers).

You have other options here too, but don’t use any of them yet, Let’s just look at them. You could
change the radio buttons (Text, Binary, MacBinary, Data, Resource) if you wanted to. The blinking
vertical-bar text cursor at the beginning of the filename in the “As” box lets you change the name that
the file will be sentunder. You could change it to “raynette.txt”, for example. And the Cancel button
lets you change your mind about sending the file.
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There are three ways to start the file transfer: double-click on the file’s name, or (with the filename
already highlighted) either click on the Send button or else press the Return key on the keyboard. Pick
one of these and do it now. Mac Kermit’s file transfer status box should pop up and the mouse pointer
should change into a wristwatch to show that you should wait while the file is being transferred.

- € File Edit Settings Font Remote Log Print

Mac Kermit

ar Flle Transfer Stotus !
gﬂ;E Sending sampla.tut Texut Moda
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gaile
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Emergency exit: hold down % and {ype a period.

The file wransfer display changes continuously during the file transfer to show you the current file
name, the number of kilobytes (Kbytes, i.e. thousands of characters) transferred, the number of

Page 82 Transferring Files




packets, and so on. When the file transfer completes successfully, the status window disappears, the
wristwatch turns back into your normal terminal-screen mouse pointer, and you get your terminal
screen back. If it failed, the status window remains on the screen so you can read it:

“ & File Edit Setlings Font Remote Log Print h
Mac Kermit
g; ===—————— Fija Transfer Slalus D0
| sending
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BVE ¢
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Escap] - . .
[ Cancet Filg ] [f;msez l:rat:p]
Type a key or click the mouse ta continue.
. A

If you see a window like this now, there are two possible explanations. First, you spent too much
time observing the dialog box. VAX Kermit got tired of waiting for you to send it a file and “timed
out”. If you think that’s what happened, click the mouse to get your terminal screen back, give VAX
Kermit another “receive” command, and then send the “sample.txt” file again. If it still doesn’t
transfer, some communication setting was probably incorrect. See the section “What went wrong”
later in this chapter.

When you are finished transferring files, you can exit from the other computer’s Kermit program.
Let’s do this now and take a look at the file we just transferred to make sure it’s OK. When we have
the VMS system prompt (dollar sign) back, we tell it to “type sample.txt” and then, satisfied that the
entire file was transferred correctly, we log out from the VAX computer.

Using Mac Kermit Page 83




(& File Edit Seltings Font Remote log Print

Mec Kermit a0

C-Kerni traxit

¥ fure sangie. txt
Hac Kernil Saspla Taxt

This iz a sasple HacWrita text docunent to be transferrad by Hec Kermit.
Up abova you see @ larga beld headling, which is also in a different font
fvom the rest of tha docunent.

In this paragraph wa have boldface, ftalles, underlined texi, and various
conbinations.

Can uou use Mac Karmlt to iransfar Wls file to another Kind of conputer?
¥ lo

RO CRRRIER
|

I

If your modem connection was set up in the normal way (and you were using a Hayes or compatible
modem), the NO CARRIER message should appear shortly after you log out from the VAX. This
means that the two modems automatically hung up the phone call. If they did not, you can do this
yourself by selecting “Toggle DTR” from Mac Kermit’s Edit menu or by turning off your modem.

Once you are finished with file transfer and terminal emulation, you probably don’t need to use Mac
Kermit any more. To exit, select Quit from the file menu or, if you have a Control key on your
keyboard, you can use the menu-key equivalent, Command-Q (hold down the Command key and

press the Q key).
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Congratulations, you have just sent your first file. May you transfer thousands more!
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Sending a File from Another Disk or Folder

The files you want to send might not always be in the current folder. That’s OK because you can
change the current folder within the Send File dialog box. Above the file listis a small box containing
the name of the current disk or folder, If you want to send a file from a different folder, put the mouse
pointer here and hold down the mouse button, This will let you move “up” through the enclosing
folders, or to the desktop of the current disk, and then you can use the resulting file list to open new

folders.
{
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Clicking the Drive button switches the file list to another physical disk (if you have one), and clicking
the Eject button lets you eject a diskette so you can insert a different one.

Your choice of a different disk or folder in the Send File dialog applies only to the files that will be
transferred when you click on Send. If you want your new directory or disk selection to “stick” so
it applies to subsequent transfers too, select Set Transfer Directory from Mac Kermit’s File menu and

make the choice in the directory dialog box that is presented to you.
\

Receiving a File
You might want to use Mac Kermit to receive files from remote computers too, The procedure is the
same as for a sending file, but with the “send” and “receive” commands reversed.

To receive a file, first give the remote Kermit a “send” command for the desired file, and then select
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“Receive file” from Mac Kermit’s File menu or (if menu keys are available) use Command-R (hold

down Command and press R).

Let’s work through an example in which we log in to a UNIX computer and transfer a text file called
“marylin.resume” from the UNIX subdirectory “frank/misc’ to the Mac. This example assumes that
you have already made the connection and picks up where you log in. First, tell UNIX Kermit the
name of the file to be sent. When transferring files with Kermit, you always tell the sending Kermit

the name of the file, and it tells the receiving Kermit.

f & File Edit Settings Font Remote Log #riat

Mac Kermit

logdin: sari

Passuord:

% ed “/frank/mise

% kernit
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Now tell Mac Kermit to receive the file, Use the mouse to point to the File menu and select the
“Receive File” option.

& Edit Settings Font Remote Log ¥Print A
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Quit %0
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The file transfer status box pops up to report the progress of the transfer. There is no directory dialog
box this time because none is needed. The file transfer box disappears when the file has been
successfully transferred. If not, some communication setting was probably incorrect; see the section
“What went wrong” later in this chapter.

After logging out from the UNIX computer and exiting from Mac Kermit, you can see the icon for
the new file.
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Because this is a plain text file, you will probably have to “import” it into your favorite Macintosh
application and convert it to the desired format. If you simply double-click on a text file received
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by Mac Kermit, it should start up MacWrite on that file. Then you can use MacWrite to add special
effects like boldface so you can print a fancy copy of your resume. MacWrite will ask you how to
treat carriage returns. There is no completely satisfactory answer to this question, but it is usually
best to choose “Line Breaks”.

& TR edit Searth Format Foat Style : 3:)
shouid o Carriage Meturn signify a new paragraph or a ling
break?

[ Poragrephs JJ [ tine Breaks ] [ Cancel ]
\. h _/

Now use MacWrite’s editing features to format the file to your taste, then save it, print it, or do
whatever else you had in mind for it.

Other text processing programs may have different ways of handling the plain text files that you
transfer from other kinds of computers. If you wanted to edit text file in Microsoft Word instead of
MacWrite, you have to start the Microsoft Word application first and then “open” the text file from
Word’s File menu. Microsoft Word reads the file without a dialog, keeps the line breaks, and may
also add additional line breaks of its own, Pagemaker 4.0 can handle these files very nicely if you
import them using PageMaker’s Place command (or the Story Editor’s Import command), and then
when the “Smart ASCII Import Filter” dialog box pops up, check the boxes for removing carriage
returns at the end of every line and between paragraphs. MPW C or Pascal should accept program
source files downloaded by Kermit exactly as-is with no complaint,

Sending Groups of Files
Suppose you want to send a lot of files and you don’t feel like sitting at your Macintosh and scndmg
them one at a time. Let’s take another look at the File Send dialog box. In the contents box, you’ll
sce that some items have a picture of amanila folder next to them. These are indeed Macintosh folders
that contain files. If you highlight the name of a folder, the action button reads “Open” rather than
“Send”.
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If you click on Open, the contents box changes to list the files that are in the folder and then you can
choose a file to send from within it.

Now notice the check box marked “Send all files of the current folder” at the bottom of the dialog
box. If you check this box, something new happens: all the files in the folder are sent when you click
on Send, rather than just the selected file. If the folder contains other folders, they are not sent.
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Of course, before you can send files, you must have started the remote Kermit program and told it
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to“receive”. Thisisdonein exactly the same way you did it before. When you tell a Kermit program
to “receive”, it is prepared to receive any number of files.

Receiving Groups of Files

Transferring a group of files from a remote computer to Mac Kermit is just like transferring a single
file, except for the notation used in the remote Kermit’s “send” command. Most computer systems,
like UNIX, VAX/VMS, etc, allow you to specify a group of files using “wildcard notation,”” which
is usually done by including special characters like “*” in the filename. For example, a command
like “send *.txt” tells most host-based Kermit programs to send all the files whose names end with
“.txt”. After doing this, you simply tell Mac Kermit to receive the files by selecting “Receive file”
from its File menu.

To learn more about sending file groups from other Kermit programs, read the documentation for
those programs.

Interrupting a File Transfer
Kermit delivers files just as the Post Office delivers mail. But did you ever put a letter in a mailbox

and then realize it was mistake? Youcan’t getit back. But you can with Kermit— it lets you retract
a file transfer at any time before it is complete. Let’s look again at the file transfer status window.
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See the buttons marked “Cancel File” and “Cancel Group”? Use these by moving the wristwatch-
shaped mouse pointer to the desired option and then clicking the mouse, '

The button marked “Cancel File” does just what it says — it cancels the transfer of current file, If
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Mac Kermit was sending a file, it stops immediately, and tells the other Kermit to discard whatever
fragment it has received so far. If Mac Kermit was sending a file group, it stops sending the current
file and proceeds to the next file. The other Kermit will discard the file fragment received so far if
itsupports this optional feature feature of the protocol, otherwise the partial file is saved on the remote
computer. If Mac Kermit is receiving a file, the “Cancel File” button works if other Kermit program
supports this optional feature of the protocol.

The “Cancel Group® button can be used with either single files or file groups. For single files it works
justlike “Cancel File”. For file groups, it attempts to cancel the current file and all the rest of the files.
Again, this is an optional feature of the Kermit protocol. Like Cancel File, Cancel Group is always
effective when sending (except that a partially received file might not be discarded at the receiving
end). When receiving, Cancel Group works if the other Kermit supports it. |

The ultimate weapon in your arsenal of interruption is the Emergency Exit: hold down the Command
key and press the period () key. This cancels any file transfer operation completely, no matter
whether Mac Kermit is sending or receiving a single file or a group of files., But the Emergency Exit
cannot be used to cancel one file at a time from a file group.

Use the Emergency Exit when the file transfer does not seem to be working at all but is taking a long
time to fail. This can happen if you have certain parameters set wrong or if you forgot to start the
Kermit program on the other end. You can also use the Emergency Exit whcn the other Kermit
doesn’t seem to be responding to Cancel File or Cancel Group. :

File Defaults
So far we have transferred only text files. Now let’s ook at how to transfer binary files and how to
use MacBinary mode. To do these things, you have to go into Mac Kermit’s File Default settings
before starting a file transfer. The default settings are used unless you tell Mac Kermit otherwise.

When you are sending files, Mac Kermit determines each file's type from its directory entry. If the
type is Application (as shown by the Finder when you View by Name), Kermit sends the resource
fork in binary mode, otherwise it sends the data fork in text mode. Whenreceiving files, Mac Kermit
stores files into the data fork using text mode unless you change its file defaults.

You can change the default settings for each file as it is transferred or you can set them once for all
files. When Mac Kermit is sending, you can override its file defaults by checking the radio buttons
in the dialog box for Mode (Text, Binary, MacBinary) and Fork (Data or Resource). Remember, we
saw these options when we sent our first text file, but decided not to change them then.

To change Mac Kermit's defaults for received files, go to the Settings Menu and select “File
Defaults™.
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You will get a dialog box that shows you the current defaults and lets you change them.
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Attended versus Unattended operation,
This applies to incoming files only. Attended mode means a dialog box pops up as each file arrives,
letting you override the prevailing file defaults (mode and fork) and specify a different folder, disk,

and/or name to store it under.
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Attended mode must be used with caution —if you take too long (more than about aminute) to handle
an incoming file’s dialog box, the other Kermit could time out and terminate the operation. You can
switch from attended to unattended mode during a multifile transfer by clicking on the “Proceed
Automatically” button in the dialog box.

Unattended mode is the default, meaning Mac Kermit automatically uses the prevailing File settings
for each file received, and stores each file under the name it was sent with,

Supersede/Create New File Names
These options tell Mac Kermit what to do when a file arrives that has the same name as an existing
file. It can either supersede (write over) the existing file, or assign a new unique name to the arriving
file. New names are formed by adding a dot and a number to the end. For instance, if a file called
OOFA exists and a file called OOFA arrives, Mac Kermit stores the arriving file as OOFA.1; if
OQFA.1 exists, then OOFA.2, and so on,

Keep Partially Received Files
If Mac Kermit was in the middle of receiving a file and the transfer was interrupted for some reason,
Mac Kermit discards the partially received file rather than keeping it. This is done to prevent you
from thinking the received fragment was the entire file. An interruption could happen, for example,
because the telephone connection was broken or because you clicked on “Cancel File”, If you want
Mac Kermit to keep partially received files rather than discard them, check this box.

This is another option that you should use with caution. A possible use for it is to let you resume an
interrupted file transfer where it left off. There is no automatic way to do this — you must do it
“manually”. You could, for example, use a text editor to break out the unsent part of the file on the
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remote host, send it to the Mac, and then recombine the two pieces of the file somehow.

Mode _
The “mode” is the file transfer method, Text, Binary, or MacBinary, Text means that the file’s

character set and record format should be converted to useful form; binary means no conversions
should be done. Textand Binary are used forreceived files only. When sending, Mac Kermit figures
out an appropriate mode for the file being sent (but then lets you override it the Send File dialog).

MacBinary can be used for both sending and receiving. When sending, Mac Kermit converts the
directory information and both forks of the file to MacBinary format and sends all of this data in

" binary mode as if it were a single file. When receiving in MacBinary mode, Mac Kermit assumes that
the file being received is in MacBinary format, and attempts to decode its original directory
information, data fork, and resource fork.

Fork
The defautt file fork is effective only when receiving files. It tells Mac Kermit which fork to use for
storing an incoming file, the data fork or the resource fork. When you select MacBinary, both forks

are used.

Use above defaults for sending too
(*** Not clear what this does, if anything *#%¥)

Transferring Binary Files
Are you ready to transfer a binary file? Let’s suppose you have a Macintosh application, called
MacPaintBucket, which is capable of saving its files in a special interchange format that can be used
by its UNIX counterpart, UnixPaintBucket. In this case, we’ll say that the interchange file must be
transferred in binary mode because Kermit’s text-mode character set and record format conversions
would make it incomprehensible to UnixPaintBucket. First, create an interchange file called
PAUL.PAINTBUCKET. ' :

Follow the same procedure you used before to log in to UNIX and start up Kermit. This time, before
you send the interchange file to the UNIX computer, you must tell both Kermit programs to transfer
the file in binary mode so that neither the sending nor the receiving Kermit translates it in any way.
Give UNIX Kermit the command “set file type binary” before telling it to “receive”.
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Now select “Send file” from Mac Kermit’s File menu. When the dialog box pops up, select the file

in the normal way, but check the Binary radio button before clicking on Send:
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Receiving Binary Files

To receive a binary file, first go into the File Defaults Settings menu and check the Binary button,
and then click on “OK?”.
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When you have the terminal screen back in front of you, give the command “set file type binary” to
the remote Kermit and then give a “send” command for the desired binary file. Then select Receive
File from Mac Kermit’s File menu.
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Receiving MacBinary Files

To receive a MacBinary file, check the MacBinary radio button in the File Defaults Settings dialog
box. Notice that selecting MacBinary automatically chooses both the data fork and the resource fork.
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When you are sending the MacBinary file from another computer that is not a Macintosh, tell the
remote computer to “set file type binary”, then tell it to send the file. Then select Receive File from

Mac Kermit’s File menu:
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If you are sending the file from another Macintosh, use MacBinary mode on both ends of the transfer.

Logging File Transfer Events

You already discovered that you can keep a record of everything that comes into and out of the
communication port during terminal emulation by choosing Session from Mac Kermit’s Log menu.
'The progress of file transfer operations can also be logged in a Macintosh text file called a
“transaction log”, This log shows the names of the files transferred, the date and time, the completion
status, the file mode, and other relevant information. This feature is useful with long unattended
transfers — you can come back later and read the transaction log to find out what happened. To start

a transaction log, select Transactions from Mac Kermit’s Log menu.
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You'll get a directory dialog box that lets you pick a name for the file. The default name is “Kermit
Transaction” in the current folder on the current disk. To turn off transaction logging, select
Transactions from the Log menu again, This unchecks the transaction logging option and closes the
transaction log file,
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Because the transaction log is plain text, it does not mesh automatically with most Macintosh
applications. For example, when you try to view this file in MacWrite, you’ll get a dialog box asking
whether carriage returns should be treated as Paragraphs or Line Breaks. Choose Paragraphs to
achieve the most appropriate formatting.

Transferring Files in the Backround

In the chapter “Controlling Mac Kermit” you saw how to use Kermit with MultiFinder, Under
MultiFinder, you can transfer files in the background while you are working with another application
in the foreground. To do this, start the file transfer in the normal way and then select the desired
application from the Apple menu, or by any of the other methods provided by MultiFinder. This is
a handy feature, especially when you have many or long files to transfer and you have other work
to do on your Macintosh., ‘

Page 98 Transferring Files




What Went Wrong

Mac Kermit’s ability to transfer files depends not only on its communication setiings, but also on
special file- and protocol-related settings. If you tried to transfer a file and failed, some of Mac
Kermit’s defanlt settings may need adjustment.

You already know that you cannot establish a successful connection to a remote computer or service
unless you have your communication parameters —particularly serial port and transmission speed
— set correctly. Two other communication parameters, however, are particularly important during
file transfer; parity and flow control.

Parity

During terminal emulation, Mac Kermit makes every effort to shield you from the perils of parity.
Even if your parity setting is incorrect, there is a good chance that terminal emulation will work
correctly. '

If terminal emulation works and file transfer does not work, tell both Kermit programs to use even,
odd, mark, or space parity. Parity mismatch is the most common cause of Kermit file transfer failures.

Remember: to set parity on the Macintosh, select the Communications option from the Settings
menu. Then set “Parity/Bits” to something other than what it is. For example, try “Even/7”.
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To change the parity on most other Kermit programs, type the command “set parity even” (or “set
_parity mark”, etc).
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Flow Control

Flow control is important too. Mac Kermit can do Xon/Xoff flow control, and if the other Kermit
can do it too, you should tell it to. When both Kermits can do Xon/Xoff during file transfer, speed
can be at its maximum and data loss at a minimum. Butif the other Kermit cannot do Xon/Xoff, you
should make sure that Mac Kermit has been told not to do it either. Otherwise these flow control
signals might confuse the other computer,

Youcan turn flow control on and off by selecting the Communications option from the Settings menu
and then clicking on the check box that says “XOn/XOff flow control”.
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To get the other computer to use flow control, you must type a command to its Kermit prompt, The
command is usually “set flow xon/xoff” to turn it on and “set flow none” to turn it off.

Other Causes of Failure

There are one or two other less common causes of failure. These have to do with the format, size,
and framing of the messages that the two Kermits send to cach other. But before you can attack these
items, you have to know just a little bit about the Kermit file transfer protocol.
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How Kermit Works

All Kermit programs follow the same ‘set of rules (a protocol) for accomplishing error-free file
transfer, regardless of the computer language in which the Kermit program is written or the computer

where resides.

The sending Kermit program breaks a file up into littte pieces called packets and the receiving Kermit
program puts the pieces back together again. The packets include not only the file’s data, but also
unique begin and end markers, a length field, a sequence number, a function code (packet type), and
a “block check” used for error detection, A typical file transfer session looks like this:

“Hi Kermit, are you there? >

< “Ch, hi Kermit. I‘m here”
“I'm sending you OOFA,TXT >

< “OK, go ahead”
“Here’s the first packet” >

< \\Got it ! "
“Here's the second packet” >

< “What?”
“Here's the second packet” >

< “No, it’s the first packet”
“Here’s the second packet” >

< “OK, got it!”
“Heres the third packet” >

< “A-OK!"
“Here’s the fourth packet” >

‘ < “It’s damaged, send it again -please”

“Here’s the fourth packet” >

< “Got it~
“Here’s the fifth packet” >

< “Wait a minute, this isn't packet 5"
“Here’s the fifth packet” >

< “OK, keep those packets coming”
“That’s the end” >

< “Already? Got it, thanksl”
“No moxe files, bye’ > '

< “Goodbye to you too”

The sending Kermit initiates the conversation with a packet and waits for a reply. When a reply
comes, the next packet is sent, and so on, The receiving Kermit program checks for transmission or
sequencing errors and recovers from them by requesting retransmission of damaged or missing
packets and by discarding duplicated packets. When a good packet is received, its data is written to
the file and then it is acknowledged.

The message-exchange process repeats until the entire file is sucessfully transferred. Each file is
framed by a beginning, in which the file name and attributes are transmitted, and an end. A file
transfer session is framed by session begin and end messages, and may include any number of files.
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Kermit Protocol Settings

Mac Kermit’s Protocol settings let you change packet-related parameters for both incoming and
outgoing packets. If you have all your communication parameters set correctly, Mac Kermit’s preset
(default) protocol settings should allow file transfer to work correctly. You only need tochange them
if file transfer isn’t working, or if you want to improve its performance. The Protocol settings dialog
box looks like this:
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The block check type is 1 by default, but may be increased to 2 or 3. The higher the block check, the
more effective Kermit’s error checking during file transfer. Higher block checks, however, also add

some additional overhead.

The handshake item should be used only in the types of connections where Mac Kermit must do local
echoing, as when communicating with IBM mainframes in linemode. In these connections, the host
computer will not accept data until it has granted Mac Kermit permission to send it. When Mac
Kermitis sent a certain “handshake” character, most commonly Xon (Control-Q), it can send its next
packet. If your file transfers arc working correctly without a handshake setting, then you don’t need

one.

The Send and Receive parameters arelisted in separate columns. Characters are specified by entering
their ASCII values in decimal form. Forexample, 1is Control-A, 13 is Control-M (Carriage Return).
The RECEIVE parameters are conveyed by Mac Kermit to the other Kermit. For example, if you
set Mac Kermit’s receive-packet-length to 500, Mac Kermit tells the other Kermit to send 500-
character packets. If you want Mac Kermit fo send long packets to the other Kermit, you must give
aSET RECEIVE PACKET-LENGTH command to the other Kermit. The SEND parameters are for

Page 102 Transferring Files




overriding negotiated values, and rarely need to be used,

Start and End of Packet
Kermit packets consist entirely of printable characters, just like lines of text, but they are framed by
control characters before and after. The control character that normally begins a Kermit packet is
Control-A (ASCII character 1), and the character that terminates it is normally carriage return
(Control-M, ASCII character 13).

Start _ End

Ctrli-a Packet Fields and Data Ctrl-M

Kermit Packet

In rare cases, it is necessary to use different control characters for starting or ending packets. A
modem or some other communication device, or the remote computer or service, might react badly
to Cirl-A and/or carriage return, Changing the Send Start (or End) of Packet applies to packets that
Mac Kermit sends, and changing the Receive Start (or End) of Packet tells Mac Kermit how to
identify the beginning (or end) of packets that arrive from the other Kermit program, You must tell
both Kermit programs about these changes by modifying the Send value on one end and the Receive
value on the other,

Padding
Padding is another obscure parameter that rarely needs changing. If padding is requested, Kermit
transmits a certain number of copies of a selected character in front of each packet. These characters
have nothing to do with the Kermit protocol itself, but may be necessary to coax some piece of
communication equipment into letting Kermit packets pass by unharmed. :

Timeout

When a packet is transmitted, something bad might happen to it on its way to the other Kermit,
causing it to arrive damaged. If the condition it arrives in is bad enough, the other Kermit might not
even recognize it as a packet. In some cases it might not arrive at all. If this happens, a “deadlock”
could occur in which each Kermit waits forever for a packet from the other. To break deadlocks,
Kermit programs have internal “alarm clocks” that go off after a certain number of seconds, allowing
the lost packet to be regenerated. The Receive Timeout parameter is used by the other Kermit, The
Send Timeout is used by Mac Kermit to override the value requested by the other Kermit. A value
of zero turns off the alarm clock entirely.

Make sure your timeouts are long enough. If your timeout interval is too short, file transfers will
always fail. Mac Kermit attempts to ensure your timeout interval is long enough, butit cannot always
take external factors into account.
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Improving Kermit’s File Transfer Performance

Several factors determine Kermit’s file transfer efficiency. All of these factors result from external
forces. Mac Kermit gives you tools to make adjustments to achieve optimum performance in the
presence of these forces.

Parity
One roadblock is our old friend, parity. If you are trying to transfer 8-bit data through a 7-bit
connection, Kermit must add a prefix character to every data character whose 8th bit was originally
1, This prefixing can result in 100% transmission overhead (or more)! Therefore you should always
try to get an 8-bit no-parity connection whenever you need to transfer large amounts of 8-bit data.

Noise
Data connections, like telephone connections, are sometimes subject to interference, such as static.
This interference is commonly called “noise”. You may have seen noise in the form of “garbage
characters” appearing on your screen during terminal emulation. Noise is a major factor affecting
Kermit’s file transfer efficiency. The more noise on the connection, the less efficiently Kermit
operates. Every packet that is corrupted by noise must be retransmitted. But when you have a very
clean (noiseless) connection, you can make Kermit packets very long. The longer the packets, the
faster the file transfer. This is because the ratio of “packet overhead” toreal datais kept ata minimum.

If there is noise on the communication line, a long packet is more likely to be hit than a short packet,
and takes longer to retransmit, so it is better to use short packets.

How do you decide what to set the packet length to? The maximum length of a packet thatis allowed
by the Kermit protocol is 9024. Mac Kermit can handle this Iength, but most other Kermit programs
have smaller maximum packet sizes (2000, 1000, or even 100). Even when the other Kermit program
can also handle the maximum Kermit protocol packet length, you can’t be sure a long packet can pass
through all kinds of communication equipment (terminal servers, multiplexers, etc) unharmed, or
that a small or busy host computer can absorb a long packet without losing some characters. In these
cases, long packet transfers will fail consistently. Itmay take some time to home in on a shorter value.
Use the longest packet that works,

The default packet length is 94. The packet length is requested during protocol negotiations by the
file receiver. To have Mac Kermit request longer (or shorter) packets, enter the desired number in
the “Packet-Length” box in the “Receive” column of the Protocol Settings menu. To have Mac
Kermit send longer packets, give a “setreceive packet-length” command to the other Kermit before
giving it the “receive” command, for example “set receive packet-length 10007,
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When using long packets (longer than 95), or when transferring 8-bit data, be sure to select a stronger
error checking technique; use block check type 2 or 3, rather than 1. Alsomake sure thatthe receiving
Kermit’s timeout interval is long enough to allow fora packet of the selected length to be transmitted
at the current transmission speed. Divide the transmission speed (baud rate) by 10 and multiply the
result by the current timeout. If the answer is less than the packet length, you must either increase
the timeout or reduce the packet length:

speed / 10 x timeout > packet-length 7

For example, on a 2400 bps connection with a 5-second timeout:
(2400 / 10 =240) x 5= 1200

so the longest possible packet is 1200 characters. If you want to have 2000-character packets, you
must make sure the receiver’s timeout interval is at least 9 seconds.

Transmission Delays

Another factor affects Kermit’s performance when connections are made over wide-area networks
or earth satellites: transmission delay — the extra time it takes for a message to travel from its source
to its destination. When earth satellites are involved, this delay can be up to about one second. A
second doesn’t sound like very long to wait for a message, but when you have a 9600 bps connection,
each second wasted in transmission delays could have been used to transfer about 1000 characters
of data, Wide area networks often have even longer delays, especially during peak usage hours when
they are congested.

There is a lot of time wasted while Kermit stops and waits for a reply after sending each packet. An
optional feature of the Kermit protocol, called “sliding windows”, lets Kermit send multiple packets
before requiring any replies. The number of packets that Kermit can send before a reply comes back
is called the “window size”,

The default window size is 1. To use a larger window size, enter the desired number (up to 31) in
the “Sliding Window Size” box of the Protocol Settings Dialog box. Use larger window sizes for
longer delays. Sliding windows can be used only if the other Kermit also supports this feature. This
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feature is supported by MS-DOS Kermit 3.0 and later, C-Kermit 5A and later, Prime Kermit, and of
course other Macintoshes that are running Mac Kermit 1.0 or later. You must also tell the other
Kermit to use the same window size. Use the command “set window’ with the desired size, for

example “set window 4”,

f &

File Edit Setiings Font Remote Log Prinl

Mac Kermit

F 4
$ kernit

Tupa ? or ’help” for help
C-Keraltisel wirclow 4
CKarni 5N

C-Kermit BALI00), 8 Feb 80, 4.3 33D

When the other Kermit does not support sliding windows, you can use longer packets to increase the
efficiency of the file transfer, but only if the connection is relatively noise-free,

Startup Files

The startup files distributed with Mac Kermit include appropriate, but conservative, protocol
settings. The objective is to give you the protocol settings that are most likely to work, even at the
possible cost of file transfer efficiency.

f_F ® File Edit mim Font Hemote Log Print h
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Padding 1] 0
Seconds for timeout ? 1a §
Packetlength (90 g0 | [ cancel ) g
(N S
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Let’s create a startup file with longer packets, sliding windows, an increased timeout, and a higher
block check. Move the mouse pointer to the Settings menu and select the Protocol Settings option,
Move the mouse pointer to the Sliding Window Size box, click just after the 1 and press the delete
key on the keyboard to erase the current number. Now press the number 4 to set the new window
size. Go to the Block Check Type choices and select the button before the number 2. Then move
the mouse pointer to the Seconds for timeout option and change the Receive and Send boxes to 10
each. Finally, move down one line and change the receive packet length to 800, The result should

look like this:
& File Edit BTN font Remote Log Print )
Adar ¥armld
i Pratocol Setlings siiding Window Sizo [4 | @
‘|f Block Check Type O ®2 O3
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Start of packet char 1 t
End of packet char 13 i3
Pad char 14 a0
Padding 0 0
Saconds for timeout it 10 1o
Pocket lenglh 80D 90 | {cancel ] _EJ

Now click on OK., After the protocol settings box goes away, select “Save Settings” from Mac
Kermit’s File menu. Type a new namie for the startup file you are about to create, and then press the

Return key.
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You’ve just created a settings file that you can use again and again.
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Using a Kermit Server

By now you are familiar with Kermit file transfer and you know that it can involve a lot
communication with both computers. You might find it tedious to continuously switch back and
forth: use the mouse to talk to the Mac and the keyboard to talk to the host, go back to the mouse,
then to the keyboard again.

The basic method of file transfer described in the previous éhapter can be used with all other Kermit
programs. In fact, there are some Kermit programs that support only this mode of operation, called
“send-receive mode.”

But many Kermit programs also offer a more convenient method for transferring files, called “server
mode.” When you put the remote Kermit program into server mode, it responds automatically to the
commands you give to Mac Kermit. If you tell Mac Kermit to send a file, you don’t have to tell the
remote Kermit server to receive it; it just will. If you tell Mac Kermit to get a file from the server,
the server sends it without further ado. Mostrernote Kermit servers offer additional services too: get
a directory listing of files on the host, change your working directory on the host, execute a host
command, and so on. These services can be accessed by making simple menu selections in Mac

Kermit,

Starting the Server

To use a remote Kermit server, make the connection to the remote computer or service and log in to
it in the normal way. Start the remote Kermit program, give it any necessary communications, file,
or protocol settings, and then give it the “server” command. From then on, Mac Kermit controls
everything. The commands you issue are relayed automatically to the server and the server executes

them,

In this example, we dial up and log in to an IBM mainframe VM/CMS computer, using a half-duplex
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linemode connection. Mac Kermit was started from the IBM-Line-1200 startup file. Notice the
double echo of the commands that are typed to the modem. Don’t worry about this — the modem
echoes, but the mainframe computer does not. The double echoes stop as soon as the connection is

made,
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CORNECT
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. logon mary
eRTeT password: XXKKOHHEX

LOGON AT 20:14:51 £5T WEDNESDAY 12/712/90
YA/SP REL 6 04/19/88 19:39

cHs

Jermit

Kermi b-CHS Yarsion 4.1.008 <{30/2/14)
Entar ? for & list of walid comnands

Kerni t-CHS>server
Entering sefver mode. Plesse escapa to local Kernit now.
To terminate the server use lhe BYE or FINISH commands.

When a Kermit server starts, it gives a message like this. If you have not used Kermit on other kinds
of PCs, you probably don’t know what “escape to local Kermit” means. Don’t give it a second
thought, This phrase applies to the way most other Kermit programs work but not to Mac Kermit.
With the Macintosh, you always have a terminal screen, and commands are always available in the

mentt,

When the remote Kermit program enters server mode, you are no longer expected to type anything
in Mac Kermit’s terminal window. In fact, just about anything you do type will be ignored. From
now on, all actions are initiated from Mac Kermit’s menu by mouse selections or command keys.

~ File Transfer

Sending files to a remote Kermit server works exactly the same way as sending files to a Kermit
program that has been given the “receive” command. The only difference is that this time you don’t
give the “receive” command to the remote Kermit. Goto Mac Kermit’s File menu, select “Send File”
and follow the normal procedure for sending a single file or all the files in a folder.
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When the transfer begins, Mac Kermit’s regular file transfer status window pops up, with its Cancel
File and Cancel Group buttons and its Emergency Exitkey. These too work in the normal way except
that the server remains in server mode after an interruption.

Getting files from a Kermit server, however, is @i<not> the same as receiving files from a Kermit
program that has been given a “send” command. The “send” command identifies the files to be
transferred. If you give Mac Kermit a “receive” command with a Kermit server on the other end,
neither of the Kermit programs knows the name of the file you want transferred. So, to getfiles from
a Kermit server to your Mac, select the “Get file from server” option from the File menu.
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When you ask Mac Kermit to get a file from the server, you get a dialog box. In this box you must
type the name of the file or file group you want the remote Kermit server to send to the Mac. The
filename must be in the syntax of the remote computer, for example OOFA.TXT or QOFA.*. The
“Get” button remains dimmed until you have typed in a file name. To start the transfer going, click
on the Get button or press the Return key.

__mtdil Sellings font Remote log Print

18M-Line~1200

s
kernit
B Tvpe name
Handshake || ot remote file: ﬁ of file In
g'{”i: Tant this box

oofa.lk
To ::r:?n I r<\

L s [ tancel }

o

Remote Commands

Mac Kermit also lets you give special commands to the remote server to perform file management
and other functions on the remote host, There is no guarantee that every Kermit server can respond
to all of them, If Mac Kermit sends a Remote command that the server doesn’t understand, the
server’s response will be something like “Unknown Remote command.” A Remote command that
is in progress (or that appears to be stuck) can be canceled by taking the Emergency Exit (Command-
.). Here is Mac Kermit’s Remote menu, with the UNIX C-Kermit server shown in the background:
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The response (if any) from a Remote command is displayed in a special pop-up window called the
Response window. This is a fully accessorized Macintosh window that can be dragged by its title
bar, sized with its size box, scrolled vertically or horizontally with its scroil bars, and copied from
using the I-beam mouse pointer and Edit menu. Responses to multiple Remote commands are
separated by dashed lines.
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The response window can be hidden by clicking “Hide Response” in the Remote menu or clicking
on the Response window’s go-away box.
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Allthe text in the Response window remains intact while it is hidden. To bring the response window
back to the foreground, click on Show Response in the Remote menu.

The Response window also pops back up automatically any time the server sends something to i,
If the Response window gets too full (more than about 30,000 characters), Mac Kermit removes
enough text from the beginning, in 512-character chunks, to make it less than 30,000 characters

again,

When you select a command from the Remote menu, a dialog box pops up that contains one or more
text boxes for you to enter additional information (a filename for example) from the keyboard. This
information is usually optional; a sensible default value is used if you don’t type anything, Thereare
also two buttons, marked “Do It” and “Cancel”.
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z Do 'U]h[ Cancel ]
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Click on “Do It” or simply press the Return key to start the Remote command. Click on Cancel to
change your mind. Mac Kermit’s Remote menu includes the following commands:

CD
(Change Directory) Tells the Kermit server to change its default directory to the one you type in the
dialog box. If youdon’ttype one, the remote serverreturns to its login or home directory. Some host
computers may also require you to supply a password when changing directories; a box is provided
for that too.
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The term, “default directory” refers to the directory to use if no directory is specified. In Kermit, if
you give the server a filename without a device or directory specification, it looks for the file in its
default directory. In the example above we chose to make ~jrd the default directory for the UNIX
computer that we are connected to, Then if we told Mac Kermit to “Get” the file “msxibm.asm”, it
would send “~jrd/msxibm.asm”, You can still refer to files in other directories by including the
directory path in the filename. For example, you could ask for the file “~pwp/ckmfio.c” even though

your default directory is “~jrd”,
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Delete File
Tells the remote Kermit server to delete (remove, erase) the file or file group whose name you type

in the dialog box. If you don’tinclude a device or directory specification, the file is deleted from the
current device and directory on the server, There isno default filename. You must specify the file(s)

you want deleted.
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Directory
Asks the remote Kermit server to send a listing of the files in the current directory, or in the directory

whose name you type in the dialog box, or the files that match the file group specifier that you type
in the dialog box.
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The directory listing is shown in your response window, It is in the format used by the remote
computer, as in this example for UNIX:

~
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Help
Asks the server to send a list of the commands it can respond to. The dialog box includes a text box

that lets you request help on a particular topic, but most Kermit servers ignore this and just send you
a list of commands. The server’s help text appears in Mac Kermit’s response window, as in this
example for an IBM mainframe VM/CMS Kermit server:
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Host

Asks the server to pass the command that you type in the dialog box toits host operating system, and
to send the results (if any) back to Mac Kermit’s response window. You should only run host
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commands that are not interactive and that display their results as ordinary text without graphics or

special effects. ‘There is no default host command.
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Asks the server to furnish a brief report on disk spaced used or available on its computer. You can

also specify a particular device or directory in the text box.

Type

Asks the server to send the contents of the text file whose name you type in the dialog box for display
in the response window.
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ledin: anne
Password:

# kermit

L-Kermit 5AC100), § Feb B0
Tupe 7 or ‘halp’ for help
C-Kernitiserver

.

If you ask Mac Kermit to “Remote Type” a binary file, you will see a lot of funny-looking symbols
in the response window because Kermit is trying to interpret the file as text when it really isn’t.
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Who
Asks the server to send a report to the response window about the users who are presently logged in
to its computer or, if you type a name or user ID into the dialog box, a report on the specified user,
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-Karnilisarver E{7J== nremote Response

C-Kernil server siarting, Retun
1
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Bl tigpd  Dec 26 18:32
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Leaving Server Mode

To disengage from the remote Kermit server, click on “Finish” or “Logout” in the Remote menu,

’r ™
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connands fyon thare, To shu Tx* Delete file... »
BYE command to Jogoul, or ih aargad ﬁ]l‘lﬁclﬁrg... 21:
[ . rose 111
eit Host... az
Space,.. w
K[| Tupe.. Bl
Wwhae..
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“Finish” puts the remote Kermit program back in interactive command mode so you can change its
settings or make it do other things, or exit from it and do other work on the remote computer.
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“Logout” logs out the entire remote session and it should also hang up your connection, Use this
- method if you don’t need to do any more work on the remote computer.

Making The Macintosh The Server

Mac Kermit is typically used to connect your Macintosh to another computer, But another computer
can also connect to your Macintosh if Mac Kermit is set up to be a Kermit server. Either way, your
Macintosh and the other computer can communicate and transfer files between them.

Connecting Two Personal Computers
You can connect two personal computers (the Macintosh isincluded in this category) using the same
methods that you would use to connect any two computers — either a direct cable connection that
includes a modem eliminator if the computers are close together, or by dialing up with modems if
they are far apart,

There are several reasons why you might want to use Kermit to connect your Macintosh to another
personal computer, For example, you could leave your Mac at work in Kermit server mode, go home,
write a report on your PC, then use MS-DOS Kermit to dial up your Mac and send the report there,
ready for printing in the morning, When you have a PC and a Mac in close proximity, you can use
aKermit connection between them as a rough-and-ready disk converter: read a Mac disk on the PC,

or a PC disk on the Mac.

Personal computers differ from timesharing computers and dialup services. There is no “host” to log
into. In order to make a PC-to-PC Kermit connection, you would normally need two people ~— one
sitting at each keyboard. This method works fine, but only when you have a person at each PC at the
same time, or when the two PCs are close enough together that one person can operate them both.

To have a PC-to-PC file transfer session when the two PCs are distant and only one person is
available, one of the PCs must be running a Kermit program in server mode. Here is how to make

the Macintosh the server:
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1. Start Mac Kermit and set the desired parameters in the Settings menus, or simply start Mac
Kermit from the appropriate startup file, like Normal-1200.

~
& Flle Edit Ulew Special Color
En Mac Kermit 1.0 =]
20 items 166K in disk 614K available
N . HF
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(&5 iy [
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Mark-9600 Mark=-2400 tark-1200
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Space-9600 Space-2400 Space~1200
(S5 o Sy
1BM-Full-5600  1BM-Full-2400  18M-Fuli-1200
A B R
S S5 [
BM-Line-9600 18M-Line-2400  18M-Line-1200 =
K] [ )
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2. If you are setting up your Mac Kermit server for dialup access, you must also put your modem
in “answer mode.” If your modem is a Hayes or compatible, type this command ATS0=1 in Mac
Kermit’s terminal screen.

F & rile Edit Settings Font Remote Llog #rint )
Normel-20 e
3t
o
atsi=l
oK
\. J

Thatis, 'type the letters ATS, the digit zero, an equal sign, the digit one, and press the Return key.
For other types of modems, follow the directions in your modem manual.
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3. Click on “Be a Server” in Mac Kermit’s Remote menu (or type Command-H).

[ s

Filo Edit Selfings Font TV T0ICE Loy Print
N Show Responsa

at

ats0=t Logaut

Finish

Cwd.,,,

Delols fila...
Directory...
Help...
Host...
Space.,,
Type..
Whe...

4. When Mac Kermit enters server mode, the file transfer window is displayed. At this point, all
of your keystrokes except for Command-. (Emergency Exit) are ignored, and afl your mouse

selections except for Cancel File and Cancel Group are ignored.

F &

File Edit Setlings Fonl Remote Log Print

at
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Normat-2400
=—=——=———— [ilo Transfer $iatys =——==——

Recelving

Ris ]
KBytes: Packets: ftetrias:
Window slze: Packet size: Checksum:

@

I Cancel Fila ' [Cancel Group

Emergency exit: hold down & and tupe a perlod.

5. Ok, good. The Macis all st up as a server. If you are not the person operating the computer that
will be connecting to your Mac server, you are all done. Go do something else. It is up to the
other computer owner to take it from here. That person must set up the other side to match yours
and issue commands to the Mac Kermit server.
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IBM PC to Mac Server
Mac Kermit is already in server mode and it is awaiting commands from the other Kermit program. ‘
Let’s use MS-DOS Kermit on an IBM PC to connect to the Mac. |

Start the Kermit program on the PC that wants to contact the Mac server. Setits communication and
protocol parameters to match the ones set on the Mac. Dial up the Mac if necessary.

Axkermit (DOS directory)

MS-Kermit>set port coml (Select the communication port}
MS-Kermit>set speed 1200 {Make speed match modem and Mac Kermit)
MS-Kermit>connegt {Iet me dial the modem now)

AT {Get the attention of the modem)

OK {Modem xesponds)

ATDT9876543 {(Dial the Macintosh’s number)

CONNECT 1200 {Connection established!)

Alt=X {Hold down the Alt key and press X)
MS~Kermit>

As you can see, MS-DOS Kermit works a bit differently from Mac Kermit. It uses interactive
keyboard commands rather than a mouse menu, and you must use the CONNECT command to get
to the terminal screen, and you must type Alt-X to return to the command prompt, This is where you
should be now. At this point you can issue commands to the Mac Kermit server. The commands are:
SEND, GET, REMOTE DIRECTORY, FINISH, and BYE. These command options permit you to
see what files are stored on the Macintosh and then get them. Or, to put files onto the Mac.

You can send single or multiple files o a Mac Kermit server and you can @i<get> a single file from
its current folder by name. You can also get all the files in the current folder by using a colon (%) as
the file specification in the GET command, as in “get :”,

MS-Kermit>get cofa.txt (ask the Mac to send the file cofa.txt)
{(the file is transferred...)}

MS-Kexrmit>get, ¢ (Ask Mac to send all files in folder}

MS-Kermit>dir (Show the files on the IBRM PC)

DPirectory of C:\DAVE
VINCENT DOCC 650239 2-08-90 4:59p

MICHAEL RES 8089 11-22-90 5;5la
MONJA RES 12863 1-01-91 0:00a
OOFA TXT 54321  2-14-86 9:00a
DONNA RES 9723 6-08-90 3:33p

GEORGE RES 14795 12-25-90 6:00a-
6 File(s) 1302528 bytes free
MS-Kermit>gend monja,res {Send a file to the Macintosh)
(the file is transferred...)

If you send the FINISH command, Mac Kermit returns to terminal mode. If you send the BYE or
LOGOQUT command, the Macintosh restarts itself.

MS-Kermit>f£inish {Disconnect from Mac Kermit server)
CR...
MS-Kermit>logout. (Disconnect and restart the Mac)
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You can also take Mac Kermit out of server mode from the Mac keyboard by typing the emergency
exit sequence, Command-period.

Macintosh to Macintosh Server

The remote Mac Kermit program is already in server mode. Now start up the local Mac Kermit
program with the same startup file, say Normal-1200, to initiate the connection. Dial the modem in
the normal way, Once the connection is established, use the remote Mac Kermit server just as you
would use any other Kermit server: send files to it, get files from it, request directory listings from
it, and so on. '

When you are done using the remote Mac Kermit server, select the Finish option from the Remote
menu to leave the other Mac Kermit in server mode for the next caller, or select the Logout option
from the Remote menu torestart the remote Macintosh, so that subsequent callers will not have access

to it.
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International Character Sets

*#% THIS CHAPTER IS NOT WRITTEN YET ##*

The Macintosh supports an extended version of ASCII, with characters like accented and umlauted
vowelsinthe 128-255 range. These characters allow representation of Roman-based languages other
than English, but they do not follow any of the ISO standards for extended character sets, nor do they
correspond with any other computer manufacturer’s character sets, and so they are only useful on

Macintoshes.
*#% Show Macintosh character set *#%

Mac Kermit removes these restrictions during both terminal emulation and file transfer.

Terminal Character Sets

Mac Kermit supports both 7-bit and 8-bit terminal character sets. Unless you tell it otherwise,
incoming 7-bit characters are displayed as US ASCII, and 8-bit characters are displayed as DEC
special graphics. To selectadifferent arrangement, go to the Settings menu and select Character Set.
Here you will see two columns of character set names:

*% Show Character Set box %

You are allowed to pick one from column A, one from column B. Choices in Column B refer only
to the graphic characters of the right half of the selected character set.

How do you know which character to use? The usual answer: this information should appear in the
documentation for the computer or service you are accessing from Mac Kermit; if you cannot find
the information, experiment. For example, if you live in Italy, try checking Italian National, If
accented Italian letters do not look correct on your screen, then check US ASCII and ISO Latin 1.
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8-bit character sets can only be used on 8-bit no-parity connections, or on 7-bit connections that
observe “shift-in/shift-out” protocol.

Only US ASCII should be selected from the left column when an ISO 8-bit setis selected in the right,
because ISO character sets all incorporate US ASCII as their “left halves”.

The method for typing international characters during terminal emulation is...

File Transfer Character Sets

*%% To be written ¥#%
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Command Summary

This chapter contains a brief summary of Mac Kermit's commands, organized by menu.

File Menu

The File menu is used with settings files and for file transfer.

Load Settings
A directory dialog box pops up. Choose a Mac Kermit settings file from which to set all file,
communications, terminal, protocol, and keyboard settings at once.

Save Settings
A directory dialog box pops up. Choose a file in which to save all of Mac Kermit’s current file,
communications, terminal, protocol, and keyboard settings. The resulting file can be loaded atalater
time using Load Settings, or it can be opened from the Finder to start Mac Kermit with the saved

settings.

Get file from server
A dialog box pops up. Enter the name of afile on the remote computer, whichmust already be running
a Kermit program in server mode. Mac Kermit asks the remote Kermit server to send the specified
file or files.

Send file
A directory dialog box pops up. Choose an existing file, or click on a special box to send all files in
the current folder. You may also click on special buttons to choose text, binary, or MacBinary file
transfer mode, and (for text and binary only) whether to send the data fork or the resource fork, The
remote computer must be running a Kermit program which has already been given a RECEIVE or
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SERVER command.

Receive file
One or more files is received from the remote computer, which must already be running a Kermit
program that has been given a SEND command. Files are received according to Mac Kermit's

current file defauits,

Transfer stats
Display statistics about the most recent file transfer,

Set transfer directory
A directory dialog box pops up. Choose a Macintosh disk and directory to be used by default in
subsequent file transfer commands.

Transfer to App
A directory dialog box pops up. Choose an application. Mac Kermit exits and the selected
application starts.

Quit
Mac Kermit exits to the Finder.

Edit Menu

The Edit menu contains the normal Macintosh text-editing tools plus several special communica-
tions-related functions. The text-editing functions are operational only when Mac Kermit’s terminal
cursor has the shape of an I-beam, that is, when “Mouse -> arrow keys” is not selected.

Undo
777

Cut
7

Copy
Copies selected text from the terminal screen or response window to the clipboard.

Paste
Pastes text from the clipboard to the terminal screen.

Clear
7?
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Send Break
Sends a BREAK signal out the serial port (a binary zero lasting about 1/4 second).

Send Long Break
Sends a 2-second BREAK signal.

Send XON
Sends an XON (Control-Q) character out the serial port.

Toggle DTR

Momentarily turns off the serial port’s Data Terminal Ready (DTR) signal, which is supposed to
make the modem hang up the phone and return to command mode.

Settings Menu

The Settings menu gives you access to dialog boxes in which you can change the details of Mac
Kermit’s file transfer, data communications, and terminal emulation behavior.

File Defaults
A dialog box appears in which you can choose the modes in which files are received: the file mode
(text, binary, MacBinary), the fork (data or resource), the filename collision action (overwrite or
make new name), and attended versus unattended operation. Attended means that Mac Kermit will
stop and give you a chance to change the file name, mode, and fork when each file arrives.

Communications
The communications settings dialog box lets you choose the transmission speed (baud rate), the
parity and data bits, the modem or printer port, the flow control, and whether Mac Kermitshould hang
up the phone when it exits.

Protocol

The protocol settings dialog box lets you modify the behavior of the Kermit file transfer protocol:
the sliding window size, the error checking technique, the line turnaround handshake to be used in
half-duplex connections, the packet start and end characters, the packet length, and the timeout
interval.

Terminal
The terminal settings dialog box lets you change how Mac Kermit’s terminal emulator works. You
can change the screen size, echoing, cursor shape, automatic keystroke repetition, automatic line
wraparound, and so forth. Several items are of special interest: whether or not to accept 8-bit
characters (you must check this box if your host uses an international character set), whether to act
upon received control characters or just display them symbolically, whether the mouse should be
used for editing (cut and paste) or to simulate arrow keys, and whetherreceived BEL (bell) characters
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should be andible (beep) or visible (ﬁash). There is also a Reset Terminal button to clear the terminal
screen as well as any confusion in the terniinal emulator.

Character Set
In this dialog box you may select which character sets are to be used in the “left half” and “‘right half”
of the 8-bit character code space. Normally 7-bit characters (those with their 8th bits set to zero) are
US ASCII and 8-bit characters (those with their 8th bits set to one) are from the DEC Technical set. -
You may choose a 7-bit National Replacement Character Set in the left half, or you can use ASCII
in the left half and any of various international or technical character sets in the right.

Command-Shift-1..9 active
The Command-Shift-digit key combinations are normally used by the Macintosh operating system
to perform special functions, like screen shots. Selecting this menu item removes the check mark
and makes these key combinations available for assignment as key macros. Selecting itagainreturns
these key combinations to the operating system:.

Menu Keys active
Selecting this menu item removes the check mark and disables Mac Kermit’s menu key shortcuts,
such as Command-S for Send, Command-R for Receive, etc. Selecting it again puts back the check
mark and enables menu key shortcuts again. Menu keys only work if your keyboard has a Control
key; otherwise, Mac Kermit treats the Command key as a Control key.

Set key macros

This item presents you with a series of dialog boxes in which you are asked to choose a key or key
combination, and then to assign a character or sequence of characters to it. From then on, the
characters you have assigned are transmitted out the serial port whenever you enter that key or key

combination.

Set modifiers

This item allows you to assign the Control, Caps Lock, and Meta (set 8th bit to one) functions to any
of the Macintosh’s modifier keys: Control, Option, Caps Lock, Shift, or Command.

Font Menu

The Font menu lets you choose a font and size to be used on the terminal screen. The list of fonts
includes all the fonts you have installed on your system. The VT100 font is specifically designed
for use by Kermit and corresponds with its interpretation of character codes sent by the remote host.
Other fonts have different assignments for 8-bit characters.
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Remote Menu

"The Remote menu contains commands to be sent to a remote Kermit server, The remote computer
or service must already be running a Kermit program in server mode.

Show/Hide Response
Responses to server commands appear in their own Response Window. Select this item to hide the
response window when it is showing, or to show the response window when it is hiding.

Finish
Tell the remote server to exit from server mode back to interactive command mode so you can carry
on further business with the remote host in the terminal emulation window.

Logout
Tell the remote server to terminate your entire session on the remote host or service, to log you out,
and hang up your phone connection.

CD
Tell the remote server to change its current (default) directory.

Delete file
Tell the remote server to delete the specified file(s) on its own computer,

Directory
Ask the remote server to send a directory listing of the specified files, device, and/or directory (or,
if none specified, the current directory) to your response window.

Help
Ask the remote server to send a brief summary of the commands it supports to your response window.

Host
Ask the remote server to ask the remote host operating system to execute the specified command.

Space
Ask the remote server to send a brief report on disk space used or available.

Type
Ask the remote server to send the contents of the specified file to your response window.

Who
Ask the remote server to send information about the specified person to your response window, or
if no particular person is specified, a listing of all active users.
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Be a Server
Tell Mac Kermit to enter server mode itself, so that other computers can access your Macintosh, send
files to it, get files from it, and so forth.

Log Menu

Mac Kermit’s Log menu lets you record information about your terminal session and file transfer
activity. :

Session
The session log records all the characters you see on your terminal screen, as well as any escape
sequences sent by the host.

Dump Screen
The screen dump file contains an image of your terminal screen, without escape sequences.

Transactions
The transaction log contains a list of all the files that were transferred by Kermit, along with dates,
times, sizes, and other information.

Packets
The packet log contains the packets sent and received by Mac Kermit during file transfer.

Priht Menu

(*** Mac Kermit presently includes no printer support #%%*)
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Glossary

Alert Box
A Macintosh dialog box that pops up when something has gone wrong, or when the Macintosh thinks

you are about to lose or destroy some work.

Analog
Representation of computer data in some other form, like the kind of sound waves that are transmitted

over telephone lines by modems. Also see Digital.

ANSI
The American National Standards Institute, anonprofit nongovernmental organization supported by

more than 1000 trade organizations, professional societies, and companies, which serves as the
USA’s representative to the Internaional Organization for Standardization (ISO). ANSI standards
relevant to asynchronous data communication include the ASCII specification, the character
structure and parity standard, and the bit-sequencing standard.

Answer
One of two modes a modem can be in, In answer mode, the modem waits for a call. Also see

Autoanswer and Originate.

Application
A computer program, typically one that you spend some time interacting with, such as a word
processor, spreadsheet, database, electronic publishing package, statistical analysis package, or a
communication software package. Each application has its own unique set of commands.
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Arrow Keys
Keys on the keyboard with arrows printed on their keytops. Arrow keys usually produce special

codes to control the position of the cursor on the screen.

ASCII
American Standard Code for Information Interchange. A 128-character code widely used by
computers, including the Macintosh, for storing and transmitting character data, in which characters
are associated with numbers 0 through 127, The Macintosh character set also includes many other
symbols not representable in ASCII, represented by the numbers 128 through 255.

Asynchronous
Serial transmission of Character- or byte-oriented data with delimitation of characters accomplished

by start and stop bits. Used by terminals, PCs, modems, host terminal ports, and the Macintosh
modem and printer ports.

Autoanswer
A way of setting up a modem so it automatically answers a telephone call without manual

intervention,

Autodial
A kind of modem that can simulate a telephone’s dialing mechanism, rotary or Touch-Tone, under

computer control.

Baud
As most commonly used in data communications, “baud” is the transmission speed, expressed in bxts

per second (bps).

Binary
Referring to the number two. Binary notation is a way of writing numbers using only the two digits
0 and 1. Computers are made out of switches that have only two states, on (1) and off (0).

Binary File
A file containing codes that are used to control a device like a computer, printer, or display. The
contents of binary files usually depend on some particularhardware, and they should notbeconverted
or translated in any way during transfer to another system.,

Bit
A binary digit, 0 or 1, The smallest unit of data representation in a computer.

Block Check
A quantity formed from a block (packet) of data by combining the numeric values all its bytes and
then transmitting the result with the block itself so that the receiver of the block can determine
whether it was corrupted in transit. Kermit supports three types of block checks: a one-character
checksum (6 bits), a two-character checksum (12 bits), and a three-character CRC (16 bits). Also
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see Checksum, CRC,

bps
Bits per second, data transmission speed.

BREAK
A binary zero on a communication line lasting about 0.275 seconds. This is not a valid character at

any transmission speed, and so the receiver is supposed to notice it as a special kind of signal.
BREAK is generated by pressing Command-B on the Mac keyboard or selecting BREAK from the
Edit menu during Kermit terminal emulation, Also, a “long BREAK” lasting about 3.5 seconds, is
produced by selecting Long Break from the Edit menu.

Buffer
A place to put arriving data until the intended recipient can get around to reading it, or a place to store

outbound data until the transmitter gets around to sending it.

Byte ‘
Aunitof storage, abbreviated B, intended to hold a character, usually 8 bitslong. Computer memory
and disk capacity are often measured in thousands (K) or millions (M) of bytes (for example, 256K B,

10MB).

C
The programming language used predominantly on UNIX systems, and in which Mac Kermit is

written,.

Carriage Refurn
ASCII character number 13 (Control-M). The control character that is transmitted when you press

the Return key, and which is used to terminate lines of text in a Macintosh text file, and which can
often be used as ashortcut for exiting a dialog box. Abbreviated CR. This characteris also the normal

terminator for Kermit packets,

Carrier
A continuous signal that is sent between two modems. The presence of carrier tells one modem that
the other modem is in data transmission mode. The loss of carrier indicates the data connection is
broken. An external modem usually has a carrier status light to let you know whether it is

communicating with the other modem.

CD
(1) Carrier Detect. A signal to the PC from the modem indicating that it is connected to another

modem. Also called Data Carrier Detect (DCD) and Received Line Signal Detector (RLSD). (2)
Abbreviation for Change Directory, as in Mac Kermit's Remote CD command.
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Character
A discrete unit of textual or control information, such as a letter, digit, or punctuation mark, belonging

to a particular character set, like ASCII, Apple Quickdraw, or ISO Latin Alphabet 1.

Check Box
A small square in a Macintosh dialog box. Clicking on the square alternately write or removes an

X. When an X is in the box, the corresponding feature or option is selected.

Checksum )
A block check based on the arithmetic sum of all the bytes in a block.

Click
To push down on the Macintosh mouse button and then let go, without moving the mouse.

CloseView
A utility distributed with Macintosh system software that lets you magnify portions of the screen.

Code
In data communications, the numeric or internal representation for a character in a particular

character set, like ASCII, in which (for example) the code for the letter A is 65.

Connector
A plug, of either male or female gender, that provides contacts for one or more wires within a cable

and that mates with a similar plug of opposite gender to provide the desired electrical circuits. The
connectors used most commonly with the Macintosh for data cornmunication are D-connectors with
9 pins (DB-9) or small round 8-pin Mini-8 connectors.

Console
The primary input/output device with which a person controls a PC, workstation, or a time-sharing

session on a shared computer. On a Macintosh, the keyboard and screen. On a time-sharing system,
a terminal,

Control Character
An ASCII chararacter in the range 0 to 31, or ASCII character 127, contrasted with the printable, or

graphic, characters in the range 32 to 126, Produced on an ASCII terminal by holding down the
Control key and typing the desired character; for example, Control-A is produced by holding down
the Control key and pressing the A key. Standard 8-bit character sets such as ISO Latin-1 also have
32 additional control characters inthe range 128to 159, but the Macintosh character set hasadditional
printable (graphic) characters in these positions.

CR
See Carriage Return,
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CRC
Cyclic redundancy check. An error-checking technique in which a block of data (such as a Kermit

packet) is viewed as a long sequence of bits, to be divided by a certain number, with the remainder
used as the block check.

CRLF
Carriage return and linefeed, the sequence of ASCII characters (numbers 13 and 10) used by MS-

DOS to delimit lines in a text file,

Ctrl
Abbreviation for Control. See Control,

Cursor _
The rectangular block or underscore on your screen that indicates the current position.

Data
Information as it is stored in, or fransmitted by, a computer or terminal.

Data Fork
The part of a Macintosh file that contains information. For example, the data fork of a word

processing file contains the text of the document.

DB-9
A type of data communications connector used by early Macintosh computers, having 9 conductors
arranged in two rows, and housed in a D-type connector shell, so called because its shape resembles

that of a capital letter D.

DB-25
The type of data communications connector used by most data communications equipment,

including most modems, having 25 conductor positions arranged in tworows, and housed inaD-type
connector shell.

DCD
Data Carrier Detect. See CD.

DCE
Data Communication Equipment, such as a modem or multiplexer.

DCER
See DSR,

Default
The value that is used for some parameter when no other value is explicitly provided. For example,.

the default Kermit block check is 1, and it will be used unless you explicitly tell Kermit to use type
2 or 3 by clicking on the appropriate button in the Protocol Setting dialog box.
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Desktop
Your Macintosh screen background. Using your Mac is supposed to feel like working at your desk.
You can clutter up your Macintosh desktop with folders, documents, tools, and other items.

Dialog Box
A window that pops up on your Macintosh screen when you select a menu item, or some other event

occurs, that requires further information from you.

Dialup
A data connection established with a telephone call, usually involving modems.

Digital :
Representation of data by discrete Os and 1s rather than continuous (analog) values. A computer is
digital internally, and its communication port is digital. A modem converts digital computer data to
analog waveforms (similar to speech) for transmission on telephone lines,

Dimmed
In a Macintoch menu or dialog box, a dimmed item is one that cannot be selected, either because the

option or feature is not implemented, or {more often) because it would not make sense at the current
time. For example, the File menu Eject item is dimmed if no diskette is inserted.

Din-8 :
A small round 8-bit connector used on later-model Macintosh modem and printer ports. Also called

Mini-8.

Directory
A file on adisk that contains a listof other files, with their physical locations on the disk, and possibly
other information about them, such as size and creation date. A Macintosh HFS folder is a kind of

directory.

Directory Dialog Box
The type of Macintosh dialog box that lets you create a file or open an existing file. It includes
mechanisms for changing folders and disks, looking through file lists, and (for creating new files)

specifying a new file name,

Disk :

A rotating magnetic storage medium for digital information, similar to a phonograph record, but

* possibly having more than one platter mounted on a central spindle. Disks are generally classified
as fixed, or “hard” (usually permanent, high capacity) and removable (usually single platter,
moderate capacity). The most common kind of removable disk is called a diskette.

Diskette
A single-platter, removable disk, which can be flexible, like an 8-inch or 5.5 inch floppy diskette, or

rigid, like the Macintosh 3.5-inch diskette.
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Document
A Macintosh file that is associated with a particular application. Opening a document starts the

associated application and feeds the information in the document to it. For example, a Mac Kermit
startup file.

Double Click
To Click the Macintosh mouse button twice in a row within a short period of time to open a folder,
file, or application. This is a shortcut for the normal method of clicking once to select and then

moving the mouse to the File menu and selecting Open,

Download
To transfer a file from a remote computer to your Macintosh.

Drag
To move an object on the Macintosh screen by placing the mouse pointer on it, pressing down the

mouse button, moving the mouse until the object is in the desired position, and then releasing the
mouse button.

DSR : _
Data SetReady. A signal from a modem to the PCthat says the modem is turned on and in data mode.

Also called DCER (Data Communication Equipment Ready).

DTE :
Data Terminal Equipment. A computer, terminal, or printer.

DTER
See DTR.

DTR
Data Terminal Ready. A signal from the PC to a modem that says the PC is turned on and ready to

communicate. Some modems will refuse to communicate with your computer unless it is sending
the DTR signal. Turning off the DTR signal tells the modem to hang up the phone connection. Mac
Kermit’s DTR signal is controlled from its Communications Settings menu and from its Edit menu.
Also called DTER (Data Terminal Equipment Ready).

Duplex
The degree to which data can flow in both directions in a connection. In a full duplex connection,

data can go in both directions at the same time. In a half duplex connection, data can go in both
directions, but only in one direction at a time.

Easy Access
Autility distributed with Macintosh system software that lets the modifier keys (shift, control, option,
command) be pressed before the key to be modified, rather than simultaneously with it, and that lets
the mouse pointer be controlled from the numeric keypad.
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Echo
How a character typed at a terminal, or a device emulating a terminal (such as Mac Kermit in teyminal

mode), is sent to the screen. Local echo means the terminal (or terminal emulator) itself copies the
character to the screen. Remote echo means the system to which the character is transmitted sends
it back to be displayed, and requires a full duplex connection.

Eject
Expel a diskette from the diskette drive,

ESC
ASCII character 27, Ctrl-[, Used by VT-series terminals, and Mac Kermit’s VT terminal emulator,

to introduce escape sequences.

Escape Sequence
A sequence of characters mixed in with data that is sent to a terminal (or terminal emulator like Mac

Kermit) for controlling the appearance of the screen or other behavior of the terminal, or which is
sent by the terminal when certain keys are pressed. Escape sequences for VT-seties terminals begin

with the BSC character.

Even
A kind of parity in which the parity bit is set to make the number of 1-bits in a byte even.

File :
A collection of data that is stored on a disk and that has a name. A Macintosh file has several parts:
a data fork, a resource fork, and a directory entry.

File Character Set
The character set in which a text file is encoded. During file transfer, Kermit translates between the

file character set and the transfer character set.

Fite Group
A collection of files that can be referred to using a single file specification. On the Macintosh, a group

of files that can be referred to at once by specifying a folder or selecting one or more files from the
file list in a directory dialog box.

File Mode
(or File Type) The way a file is treated by the Kermit protocol during transfer. The most common

file modes are text, in which the character set and record format of a file are converted to useful form
for the receiving computer, and binary, in which no conversions are done. Mac Kermit also supports
the MacBinary file mode, used for transferring a Macintosh application to another Macintosh or for
archiving it on a different kind of computer for later downloading to a Macintosh,
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Filename
A sequence of one or more characters that uniquely identifies a file within a particular directory or

folder on a particular disk. Filename syntax varies among different operating systems. Macintosh
filenames are less restrictive than filenames on most other computers, They can contain spaces,
punctuation (except colon), upper and lower case letters, international characters, etc.

Finder
The component of the Macintosh operating system that takes care of the desktop and starts

applications.

Flow Control :
The process by which the flow of data from one computer to another is regulated by signals sentfrom
the data receiver to the data sender, telling the sender when to stop and start transmission. Flow

control methods include Xon/Xoff and RTS/CTS (see).

Folder :
On the Macintosh, an icon that looks like a manila folder, such as you would putinto a filing cabinet.

A folder is used for collecting related items together in one place. A folder may contain files,
applications, other folders. Youcan accessthem if you open the folder. Macintosh folders are similar

to UNIX or MS-DOS directories.

Font
A particular rendering of the Macintosh (or other) character set. A font has size (expressed in
“points”), style (bold, italic, outline, etc), and design (given by names like Geneva, Courier, Long
Island, Times Roman, etc). Most Macintosh applications, including Mac Kermit, have a Font menu.

Fork
Either of two parts of a Macintosh file, the data fork or resource fork,

Full Duplex
A connection in which data can go in both directions simultaneously.

Full Screen
Said of an application that takes over the entire terminal screen. Examples are host-based screen-

oriented text editors and IBM mainframe protocol converters,

Half Duplex
A connection in which data can go in both directions, but only in one direction at a time,

Hard Disk
A high-capacity (millions of bytes) disk drive permanently mounted inside the Macintosh.

Handshake

A method for granting permission to transmit on a half-duplex communication channel, Usually the
terminal or workstation sends a carriage return as its handshake, and the host uses the Xon character
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(Ctrl-Q). Used most commonly on linemode connections to IBM mainframes.

HFS
See Hierarchical File System,

Hierarchical File System
(HFS) The present-day Macintosh file system, in which files are arranged hierarchically (in a tree

structure) through a system of directories and subdirectories, called “folders”. As opposed to the
original Macintosh File System (MES), in which folders were only used for cosmetic purposes.

Highlight
To change the appearance of an item on the screen for emphasis. Usually highlighting is done by
increasing the intensity or reversing the video. On the Macintosh, highlighting is used (for example})

to show that a menu item can be or has been:selected.

Host:
A multiuser computer or time-sharing system to which a terminal (or a computer emulating a

terminal) may be connected.

I-Beam
The shape taken by the Macintosh mouse pointer when it is in a text-editing box, including when it

is in the Mac Kermit terminal window and “Mouse -> Arrow Keys” is not selected. The I-Beam
cursor lets you select text with the mouse to be copied and pasted.

Icon
On the Macintosh, a little picture with some writing underneath, representing a disk, an application,
a folder, a document, or other object. Double-click on an icon to open it and see what’s inside.

Input/Output
The process of getting data into and out of a computer, whether from a peripheral device like a disk

or through a communication line to a terminal or another computer. Called I/O for short.

ISO
International Organization for Standardization. A voluntary international group of national

standards organizations that issues standards in all areas, including computers and information
processing,.

ISO Standard 8859
An 1SO standard specifying a series of 8-bit computer character sets that include characters from

many languages. These include the ISO Latin Alphabets 1 through 9, which cover most of the written
languages based on Roman, Cyrillic, Greek, Arabic, and Hebrew letters.

K
Abbreviation for kilo, meaning either 1000 or 1024,
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Keyboard Equivalent
On the Macintosh, some menu items can also be selected from the keyboard by holding down the

Command key and pressing the letter shown next the Command symbol (cloverleaf) on the right side
of the menu item, for example, Command-E to ¢ject a diskette.

LAN
Local area network.

Latin Alphabet
See ISO Standard 8859.

Line Mode
A type of terminal-host connection in which the terminal sends a line at a time, and the host sends

back lines with no special formatting. Terminal connections to IBM mainframes may be either line-
mode or full-screen,

Linefeed
ASClI character 10 (Control-J). Used in conjunction with carriage return (ASCII 13) to delimit lines

of textin a VAX/VMS or MS-DOS text file, and used by itself to delimit lines in a UNIX text file,
and not normally used at all in Macintosh text files.

Local g
Nearby, close to. When two computers or devices are connected, the local one is the one that’s closer
to you. When two Kermit programs are connected, the local Kermit is the one that the user interacts

with most directly, Mac Kermit is usually the local one.

Local Echo
Immediate display on the local screen, by the terminal or emulator, of characters that are entered at

the keyboard, Used on half-duplex terminal connections.

MacBinary
A special encoding for Macintosh files that allows them to be completely represented by a serial

stream of 8-bit binary bytes for transmission or archiving,

Macintosh File System
(MES) The original file system for Macintoshes, in which files with the same names cannot be be

stored anywhere on the same disk, even in different folders.

Mainframe :
Commonly used to mean a big computer, as distinct from a minicomputer or microcomputer.

Mark
A kind of parity in which the parity bit is always 1.
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Memory
The part of the computer that stores information where it can be accessed and manipulated directly.

Menu :
On the Macintosh, a list of choices from which you can make a selection by moving the mouse to

the desired menu title in the menu bar, dragging the mouse to the desired menu item, and then
releasing the mouse button.

Menu Bar
The horizontal line across the top of the screen that contains the names of the currently available

menus.

MFS
See Macintosh File System,

Mode
Sort of like mood — what mood a computer or application is in, which determines how it interprets

your “input” (keystrokes or mouse actions).

Modem
Modulator/demodulator. A device that converts between serial digital data as output from a

computer and analog waveforms suitable for transmission on a telephone line. A modem lets you
connect your Mac to another computer or service by placing a phone call.

Modem Eliminator
See Null Modem.

Modem Signals
Signals transmitted from a modem to the Mac, or vice versa, by which the modem and Mac tell each

other their status. The modem gives the CD (Carrier Detect), DSR (Data Set Ready), and CTS (Clear
To Send) signals to the Mac, and the Mac gives the DTR (Data Terminal Ready) and RTS (Reqguest
To Send) signals to the modem. On Mac models earlier than the Mac II, the serial port is capable
of accepting only one modem signal. Generally, Mac modem cables connect the modem’s CTS
signal to the Mac’s “Handshake Input”. On the Mac II and later, a second input signal is allowed,
called General Purpose Input, which the Mac modem cable should connect to the modem’s Carrier
Detect signal.

Mouse
An small device you move with your hand to direct the motion of a pointer on the Macintosh screen,

and which has a button you can push to open, select, drag, or otherwise manipulate objects on the
screetl.

Mouse Keys
A way of similating mouse movements from the Macintosh keyboard’s numeric keypad.
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Mouse Pointer
The small object on the Macintosh screen, usually shaped like an arrow pointing towards 11 o’clock,

whose movement is controlled by the mouse. The mouse pointer can assume the shape of other
objects, such as an I-beam or wristwatch, to indicate what the mouse can be used for at any particular

instant,

MultiFinder |
An operating environment for the Macintosh that lets you have more than one application open at

once, and allows one or more applications to run in the background while you use another application
in the foreground.

Multiplexer
A device that allows multiple devices to share a single communication medium. Used in pairs, one

at each end.

Network
A relatively permanent arrangement that allows two or more computers or devices to communicate

with each other conveniently and reliably at high speeds, over dedicated media, and that typically
requires special hardware and operating-system level software.

Noise
Corruption of data during transmission.

Null Modem
A pair of connectors, possibly with a length of cable between them, that allows two computers or

terminals to be directly connected without intervening modems or other data communication
equipment, and that supplies the required modem signals by means of cross-connections or jumpers.

Odd
A kind of parity in which the high-order bit of a byte is set so as to make the overall number of 1-

bits odd.

off :
(1) Not in effect (said of an option). (2) Zero (said of a bit).

On
(1) In effect (said of an option). (2) One (said of a bit).

Open
On the Macintosh, to create a window from an icon by double clicking on it (or by clicking onitonce
and then selecting Open from the File menu).

Operating System
The software program that controls a computer at its most basic level, abbreviated OS,
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Originate
The mode of operation for a modem when it places a data call, as opposed to receiving one.

0S
Abbreviation for operating system.

Packet
A message that consists of fields whose locations and interpretation are agreed upon by the sender

andreceiver, to be transmitted as a whole, and that typlcally contains sequencing, error checking, and
other control information as well as data.

Parameter
A symbolic value standing for, or to be replaced by, a real value.

Parity
A technique used in data transmission in which one bit of each data byte is reserved error detection
or some other purpose other than conveying the data itself. On a computer like the Macintosh that
stores characters in 8-bit bytes, a data connection with parity restricts data transmission to 7-bit
characters. A data connection with no parity allows transmission of all 8 bits of each byte. Also see

even, odd, mark, and space.

PC
Personal computer.

Point
In typography, 1/72 inch. A measurementof type or font size and of other items on the printed page.

Pointer
See Mouse Pointer,

Port -
Socketon the back of a computer that can be connected to a data communication device or to another

computer via a data cable. Also see Serial Port,

Prompt
Some text printed on your screen by a computer, indicating that it expects you to respond by typing

a command or some other kind of data.

Protocol
In data communication, a set of rules and formats for exchanging messages, generally incorporating

methods of sequencing, timing, and error detection and correction.

Protocol Converter
A device that converts between IBM mainframe 3270 block-mode terminal and ASCII character-

mode terminal protocols.
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Public Data Network _
A network providing access, on a subscription basis, to widely scattered and diverse services.

Telenet, Tymnet, and Datapac are examples.

Radio Button
A small round circle in a Macintosh dialog box, used to select one from a group of options. Clicking

on a radio button selects the associated option and deselects all the others in the group.

Remote :
Said of the more distant, or less directly accessed, of two connected devices. A remote Kermit is the

one running on the host that the local Kermit is connected to.

Remote Echo
The process by which a remote host computer or service sends back the characters that you enter at

the keyboard for display on your screen. Requires a full duplex connection.

Resource Fork
The part of a Macintosh file that contains executable machine code, fonts, or other kinds of data that

a user is not likely to alter.

Retry
In this book, a second or subsequent attempt at transmitting a particular Kermit packet.

RLSD
See CD.

RS-232
An Electronic Industries Association (EIA) standard that gives the electrical and functional

specification for serial binary digital data transmission, including the names, functions, and pin
assignments of the modem signals. The most commonly used interface between terminals (or
computers) and modems (or multiplexers), and the method used by Mac Kermit to communicate.
Also see Modem Signals.

RTS/CTS
A kind of data communications flow control in which the flow of data is regulated by modem signals

assigned to special wires. RTS/CTS stands for Request To Send / Clear To Send.

Scroll Bar
A bar along the bottom or right side of a window on the Macintosh screen that allows you to scroll

the window horizontally or vertically.

Select :
On the Macintosh, to choose an item from a menu by moving the mouse pointer to the menu name,

pressing the button to open the menu list, then dragging the pointer to the desired item and letting go.
Also, in a text editing environment (when the mouse pointer looks like an I-beam), to use the mouse
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in a similar manner to highlight a piece of text so it can be copied, cut, or pasted.

Serial
In series, sequential, one after another. The dominant mode of transmission of binary data over

distances greater than a few feet.

Serial Port
An computer device that sends and receives data one bit at a time, such as the Macintosh modem and

printer ports.

Server
A program or intelligent device that provides specified services to users, or clients, in response to

specially formatted requests, usually over a communication line or network. Kermit programs can
be put into server mode, in which they accept commands only from other Kermit programs.

Size Box
A little box at the bottom right of a Macintosh window that can be dragged to change the window’s

shape.

Space
A kind of parity in which the high-order bit is always zero. Also, the character thatis produced when

you press the space bar on the keyboard.

Speed
Transmission speed, in bits per second.

Speed Matching
A modem that can communicate with the computer or terminal at a designated speed, even if it is

communicating with the other modem at a different speed, for example when a dialing command is
issued at 2400 bps but the other modem answers at 1200 bps. In this situation a speed-matching
modem will continue to communicate with the computer at 2400 bps, so it will not have to change

its speed in order to use the connection.

Start Bit
A zero-bit that signifies the beginning of a character in serial transmission.

Stop Bit
A one-bit that separates characters in serial transmission.

Terminal
A device that allows a person to interact with a computer, with the person typing characters on a
keyboard to send them to the computer, and with the computer’s responses appearing on a screen or
printer. Sometimes includes the ability to interpret special character sequences to accomplish screen
formatting. In general, differs from a computer by not having local permanent memory or general-

purpose programmability.
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Terminal Emulation
Behaving like a terminal. Said of software (such as Mac Kermit) that runs on personal computers
that sends the user’s keystrokes out the serial port and sends the port input to the screen, possibly
interpreting the same escape sequences that a specific real terminal would obey.

Terminal Server
A network device that allows ordinary terminals with no networking capabilities of their own to
participate in a network by making terminal connections fo any host on the network that shares a

common protocol with the terminal server,

Text
Computer data intended for a person to read, or typed by a person, that consists of only printable
characters and those control characters necessary for format control (carriage return, linefeed, tab,
formfeed). Text files can be transferred between unlike systems and still remain useful. Also see
Binary File.

Timeout
An interval of time after which a program wakes up when waiting for some expected event (like a

Kermit packet).

Title Bar
The horizontal bar across the top of a Macintosh window, containing the title of the application,
folder, disk, or document contained in the window. The title bar of the current window is shaded by
horizontallines. The title bar may contain a “close box™ on the left and/or a “zoom box” on the right,
A window can be dragged by its title bar.

Transfer Character Set
A standard character set used by Kermit for transferring files, usually ASCH or one of the ISO 8859
Latin Alphabets. Kermit translates text files between the local file character set and the standard

transfer character set during file transfer,

Translation Table _
A list of translations from oné character code into another, for example from ISO Latin Alphabet 1

to Apple Quickdraw.

Trash
Anicononthe Macintosh screen, used fordiscarding unwanted material. Youcanrescue things from

the trash if you have not selected Empty Trash from the Special menu,

Unattended
Referring to an operation that can proceed automatically without human intervention. In Mac

Kermit, file reception can be attended or unattended.
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UNIX
A popular operating system developed at AT&T Bell Laboratories and noted for its portability.

Upload
To transfer a file from your Macintosh to another computer.

User
A person who is using a computer.

User Interface
The hardware and software with which a person communicates with a computer.

YT
Video Terminal. A series of terminals manufactured by Digital Equipment Corporation, emulated

by Mac Kermit.

Wildcard
A notation for referring to a group of files in a single file specification, by including pattern-matching
characters such as “*” to match any sequence of characters, or “?” or “%” to match any single
character. Not used on the Macintosh, but used on many of the computers that Mac Kermit can

transfer files with.

Window
(1) A rectangular area that appears on your Macintosh screen when you open an icon, It has a title
bar on top, and possibly scroll bars and other items on the right and bottom borders. (2) The number
of packets that can be transmitted by a Kermit program before an acknowledgement is required. Also

see Sliding Windows.

Workstation
A single-user computer. Equivalent to a PC or microcomputer in that the console is separate from
the communication line but is usually composed of more expensive components and intended for

more ambitious uses, and often having graphics display capabilities.

Wristwatch
The shape assumed by the mouse pointer when the Macintosh is busy, telling you that you must wait
for it to finish what itis doing. For example, the wristwatch appears during Mac Kermit file transfer.

Xon/Xoff
A method of data communications flow control in which the receiver sends an Xoff character when
its input buffer is close to filling up and an Xon when it has made room for more data to arrive. Xoff
isusually the ASCII Cirl-S character, and Xon is usually ASCII Ctrl-Q. The Xon and Xoff characters

are sent on the same wires as other data.
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